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 1
I n t r o d u c t i o n  
This chapter provides an overview of the contents of the COMSOL Installation 
and Operations Guide and some general tips for installing and running the 
COMSOL software standalone to best utilize the available computer resources.

In this chapter:

• COMSOL Release Notes

• Introduction to COMSOL Multiphysics and Online Help

• Technical Support

• Typographical Conventions

• .
 7
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Gene r a l  T i p s

Welcome to COMSOL® Multiphysics. Use this Installation and Operations Guide 
to install your COMSOL software products and start working with the packages. In 
addition to this manual, many other resources are available to help you get the most 
out of COMSOL products.

In this section:

• General System Requirements for Windows, Linux, or Mac Computers

• Hardware Parameters that Affect Performance

• COMSOL Release Notes

• Introduction to COMSOL Multiphysics and Online Help

• Technical Support

• Typographical Conventions

General System Requirements for Windows, Linux, or Mac Computers

These requirements are common to all platforms:

• A DVD drive for installation

• TCP/IP activated

• At least 1 GB memory, but 4 GB per processor core or more is recommended.

• 1–4 GB of disk space, depending on the licensed products and installation options.

• Adobe Acrobat Reader 9 or 10 to view and print the COMSOL documentation in 
PDF format 

F L O A T I N G  N E T W O R K  L I C E N S E S

Floating network licenses are supported on heterogeneous networks of Windows, 
Linux, and Mac computers. Both the license manager and the COMSOL application 
can run on either Windows, Linux, or Mac, and a single computer can run both of 
them

See Installing and Running on Windows, Installing and Running on 
Linux, or Installing and Running on Mac OS X for individual system 
requirements.Note
1 :  I N T R O D U C T I O N



Hardware Parameters that Affect Performance

• A 64-bit operating system is highly recommended.

• For a given hardware, the choice between Windows, MacOS, or Linux will not 
significantly affect performance.

• 4–8 GB physical RAM per core of the computer is recommended.

• Dual-socket or if possible four-socket nodes are recommended.

• A CPU with as fast a memory bus as possible is beneficial (QPI or HyperTransport 
bus). The numbers are often measured in GigaTransfers/Seconds (GT/s) and can 
be found on manufacturers’ webpages or Wikipedia (see example below).

• As high memory bandwidth as possible is beneficial.

• If you can find information about number of memory channels, it should be as high 
as possible. This information can be more difficult to find.

COMSOL Release Notes

When Help>COMSOL Documentation is selected from the main menu, this electronic 
PDF document provides an overview of changes throughout the COMSOL product 
line since the previous release that require special attention with regards to backward 
compatibility.

Introduction to COMSOL Multiphysics and Online Help

To get an overview of COMSOL Multiphysics’ capabilities and how to use them, see 
the Introduction to COMSOL Multiphysics document, included with the DVD 
media. It contains an overview of the major functionality in the 4.3 release and fully 
documented example models. Further, the full COMSOL documentation set is 
available on your computer in the COMSOL help resources and as a set of PDF files. 
You can also access context-sensitive dynamic help that provides help for all nodes in 
the Model Builder and windows on the COMSOL Desktop, including links to the full 
product documentation.

W H E R E  D O  I  A C C E S S  T H E  D O C U M E N T A T I O N  A N D  M O D E L  L I B R A R Y ?

A number of Internet resources provide more information about COMSOL 
Multiphysics, including licensing and technical information. The electronic 
G E N E R A L  T I P S  |  9
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documentation, Dynamic Help, and the Model Library are all accessed through the 
COMSOL Desktop.

T H E  D O C U M E N T A T I O N

The COMSOL Multiphysics User’s Guide and COMSOL Multiphysics Reference 
Guide describe all interfaces and functionality included with the basic COMSOL 
Multiphysics license. These guides also have instructions about how to use COMSOL 
Multiphysics and how to access the documentation electronically through the 
COMSOL Multiphysics help desk.

To locate and search all the documentation, in COMSOL Multiphysics:

• Press F1 for Dynamic Help, 

• Click the buttons on the toolbar, or

• Select Help>Documentation ( ) or Help>Dynamic Help ( ) from the main menu

and then either enter a search term or look under a specific module in the 
documentation tree.

T H E  M O D E L  L I B R A R Y

Each model comes with documentation that includes a theoretical background and 
step-by-step instructions to create the model. The models are available in COMSOL 
as MPH-files that you can open for further investigation. You can use the step-by-step 
instructions and the actual models as a template for your own modeling and 
applications.

SI units are used to describe the relevant properties, parameters, and dimensions in 
most examples, but other unit systems are available.

To open the Model Library, select View>Model Library ( ) from the main menu, and 
then search by model name or browse under a module folder name. Click to highlight 
any model of interest, and select Open Model and PDF to open both the model and the 
documentation explaining how to build the model. Alternatively, click the Dynamic 

If you are reading the documentation as a PDF file on your computer, the 
blue links do not work to open a model or content referenced in a 
different guide. However, if you are using the online help in COMSOL 
Multiphysics, these links work to other modules, model examples, and 
documentation sets.

Important
 1 :  I N T R O D U C T I O N



Help button ( ) or select Help>Documentation in COMSOL to search by name or 
browse by module.

The model libraries are updated on a regular basis by COMSOL in order to add new 
models and to improve existing models. Choose View>Model Library Update ( ) to 
update your model library to include the latest versions of the model examples.

If you have any feedback or suggestions for additional models for the library (including 
those developed by you), feel free to contact us at info@comsol.com.

C O N T A C T I N G  C O M S O L  B Y  E M A I L

For general product information, contact COMSOL at info@comsol.com.

To receive technical support from COMSOL for the COMSOL products, please 
contact your local COMSOL representative or send your questions to 
support@comsol.com. An automatic notification and case number is sent to you by 
email.

C O M S O L  WE B  S I T E S  

Technical Support

If any questions arise regarding COMSOL software products—whether concerning 
installation, licensing, modeling, applications, or other technical questions—do not 
hesitate to contact your local COMSOL representative or send your questions to 
support@comsol.com.

Further, at www.comsol.com/support you can find a broad range of technical support 
resources including the searchable COMSOL Knowledge Base.

Main Corporate web site www.comsol.com 

Worldwide contact information www.comsol.com/contact 

Technical Support main page www.comsol.com/support 

Support Knowledge Base www.comsol.com/support/knowledgebase 

Product updates www.comsol.com/support/updates 

COMSOL User Community www.comsol.com/community 
G E N E R A L  T I P S  |  11
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Typographical Conventions

All COMSOL user’s guides use a set of consistent typographical conventions that make 
it easier to follow the discussion, understand what you can expect to see on the 
graphical user interface (GUI), and know which data must be entered into various 
data-entry fields.

In particular, these conventions are used throughout the documentation:

CONVENTION EXAMPLE

text highlighted in blue Click text highlighted in blue to go to other information 
in the PDF. When you are using the online help desk in 
COMSOL Multiphysics, these links also work to other 
modules, model examples, and documentation sets.

boldface font A boldface font indicates that the given word(s) appear 
exactly that way on the COMSOL Desktop (or, for toolbar 
buttons, in the corresponding tip). For example, the Model 
Builder window ( ) is often referred to and this is the 
window that contains the model tree. As another example, 
the instructions might say to click the Zoom Extents button 
( ), and this means that when you hover over the button 
with your mouse, the same label displays on the COMSOL 
Desktop.

Forward arrow symbol > The forward arrow symbol > is instructing you to select a 
series of menu items in a specific order. For example, 
Options>Preferences is equivalent to: From the Options 
menu, choose Preferences.

Code (monospace) font A Code (monospace) font indicates you are to make a 
keyboard entry in the user interface. You might see an 
instruction such as “Enter (or type) 1.25 in the Current 
density field.” The monospace font also is an indication of 
programming code or a variable name. 

Italic Code (monospace) 
font

An italic Code (monospace) font indicates user inputs and 
parts of names that can vary or be defined by the user.

Arrow brackets <> 
following the Code 
(monospace) or Code 
(italic) fonts

The arrow brackets included in round brackets after either 
a monospace Code or an italic Code font means that the 
content in the string can be freely chosen or entered by the 
user, such as feature tags. For example, 
model.geom(<tag>) where <tag> is the geometry’s tag 
(an identifier of your choice). 

When the string is predefined by COMSOL, no bracket is 
used and this indicates that this is a finite set, such as a 
feature name. 
 1 :  I N T R O D U C T I O N



K E Y  T O  T H E  G R A P H I C S

Throughout the documentation, additional icons are used to help navigate the 
information. These categories are used to draw your attention to the information 
based on the level of importance, although it is always recommended that you read 
these text boxes. 

ICON NAME DESCRIPTION

Caution A Caution icon is used to indicate that the user should proceed 
carefully and consider the next steps. It might mean that an 
action is required, or if the instructions are not followed, that 
there will be problems with the model solution.

Important An Important icon is used to indicate that the information 
provided is key to the model building, design, or solution. The 
information is of higher importance than a note or tip, and the 
user should endeavor to follow the instructions.

Note A Note icon is used to indicate that the information may be of 
use to the user. It is recommended that the user read the text.

Tip A Tip icon is used to provide information, reminders, shortcuts, 
suggestions of how to improve model design, and other 
information that may or may not be useful to the user.

See Also The See Also icon indicates that other useful information is 
located in the named section. If you are working on line, click 
the hyperlink to go to the information directly. When the link is 
outside of the current PDF document, the text indicates this, 
for example See The Laminar Flow Interface in the 
COMSOL Multiphysics User’s Guide. Note that if you are in 
COMSOL Multiphysics’ online help, the link will work.
G E N E R A L  T I P S  |  13
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.

Model The Model icon is used in the documentation as well as in 
COMSOL Multiphysics from the View>Model Library menu. If 
you are working online, click the link to go to the PDF version 
of the step-by-step instructions. In some cases, a model is only 
available if you have a license for a specific module. These 
examples occur in the COMSOL Multiphysics User’s Guide. 
The Model Library path describes how to find the actual model 
in COMSOL Multiphysics, for example 

If you have the RF Module, see Radar Cross Section: Model 
Library path RF_Module/Tutorial_Models/radar_cross_section

Space Dimension Another set of icons are also used in the Model Builder—the 
model space dimension is indicated by 0D , 1D , 1D 
axial symmetry , 2D , 2D axial symmetry , and 3D 

 icons. These icons are also used in the documentation to 
clearly list the differences to an interface, feature node, or 
theory section, which are based on space dimension.

ICON NAME DESCRIPTION
 1 :  I N T R O D U C T I O N



 2
I n s t a l l i n g  a n d  R u n n i n g  o n  W i n d o w s
This section provides detailed instructions for installing and running the 
COMSOL software on Windows. You also find complete system requirements and 
license manager information. For most installations, the COMSOL Quick 
Installation Guide  that comes bundled with the DVD provides the basic 
instructions for installation on Windows. See also the COMSOL Support 
Knowledge Base on www.comsol.com/install for specific troubleshooting tips.

In this section you will find information about:

• System Requirements

• Installing COMSOL

• License Manager Installation

• Troubleshooting License Errors

• Running COMSOL

• The COMSOL Commands
 15
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S y s t em Requ i r emen t s

In this section:

• System Requirements for Microsoft Windows

• LiveLink for MATLAB Requirements

• Products for CAD Interoperability

• Parallel System Requirements

• Internet Protocol Support 

System Requirements for Microsoft Windows

G E N E R A L  S Y S T E M  R E Q U I R E M E N T S — W I N D O W S

Use Automatic Updates to keep the Windows system up-to-date. Access it and turn it 
on from the Control Panel.

S Y S T E M  R E Q U I R E M E N T S — 3 2 - B I T  W I N D O W S  VE R S I O N

• The following 32-bit Windows operating systems are supported:

- Windows 7

- Windows Server 2008 R2

- Windows Server 2008

- Windows Vista

- Windows Server 2003 with Service Pack 2 or later

- Windows XP with Service Pack 3 or later

• Intel Pentium IV or AMD Athlon processor or later

For the most current system requirements, see 
www.comsol.com/products/requirements/

Note

.
See Also
 2 :  I N S T A L L I N G  A N D  R U N N I N G  O N  W I N D O W S
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• The following 64-bit Windows operating systems are supported:

- Windows 7

- Windows Server 2008 R2

- Windows Server 2008

- Windows HPC Server 2008 R2

- Windows HPC Server 2008

- Windows Vista

- Windows Server 2003 x64 Edition with Service Pack 2 or later

- Windows Compute Cluster Server 2003 with Service Pack 1or later

- Windows XP Professional x64 Edition with Service Pack 2 or later

• A PC with one of these processors: AMD with AMD64 or Intel with EM64T

G R A P H I C S  S Y S T E M  R E Q U I R E M E N T S

Prefer hardware rendering for performance reasons: drivers supporting OpenGL 
version 1.4 or DirectX version 9 on the local console are required. Alternatively, use 
software rendering. For using the Optimize for Quality setting in graphics preferences, 
OpenGL 2.0. Hardware rendering requires at least 24-bit color graphics. Software 
rendering also supports 16 bit color graphics.

LiveLink for MATLAB Requirements

LiveLink for MATLAB is compatible with MATLAB R2012a and MATLAB R2011b.

Products for CAD Interoperability

The following products support import of 3D CAD files on Windows platforms:

TABLE 2-1:  PRODUCTS FOR CAD INTEROPERABILITY ON WINDOWS

PRODUCT SUPPORTED FILE FORMATS REQUIRED PRODUCTS

CAD Import Module ACIS (SAT), IGES, Inventor, 
Parasolid, Pro/E, SolidWorks, 
and STEP

COMSOL Multiphysics

LiveLink for AutoCAD same as above COMSOL Multiphysics

LiveLink for Creo Parametric same as above COMSOL Multiphysics

LiveLink for Inventor same as above COMSOL Multiphysics
S Y S T E M  R E Q U I R E M E N T S  |  17
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See Table 2-2 for detailed version information on the supported file formats.

L I V E L I N K  F O R  A U T O C A D

LiveLink for AutoCAD is compatible with AutoCAD 2011 and AutoCAD 2012.

L I V E L I N K  F O R  C R E O  P A R A M E T R I C

LiveLink for Creo Parametric is compatible with Creo Parametric 1.0.

L I V E L I N K  F O R  I N V E N T O R

LiveLink for Inventor is compatible with Autodesk Inventor 2012 and Autodesk 
Inventor 2013.

L I V E L I N K  F O R  P R O / E N G I N E E R

LiveLink for Pro/ENGINEER is compatible with Wildfire 4.0 and Wildfire 5.0.

LiveLink for Pro/ENGINEER same as above COMSOL Multiphysics

LiveLink for SolidWorks same as above COMSOL Multiphysics

LiveLink for SpaceClaim same as above COMSOL Multiphysics

File Import for CATIA V5 CATIA V5 CAD Import Module, 
or a LiveLink product 
for a CAD package

TABLE 2-2:  3D CAD FILE FORMATS SUPPORTED BY COMSOL PRODUCTS ON WINDOWS

FILE FORMAT (FILE EXTENSION) SUPPORTED VERSION

Parasolid (.x_b, .x_t) up to V24

ACIS or SAT (.sab, .sat) up to R22

STEP (.step, .stp) AP203, AP214

IGES (.iges, .igs) up to 5.3

Autodesk Inventor part (.ipt) 6 to 11, 2008-2012

Autodesk Inventor assembly (.ipt) 11, 2008-2012

Creo Parametric (.prt, .asm) 1.0

Pro/ENGINEER (.prt, .asm) 16 to Wildfire 5

SolidWorks (.sldprt, .sldasm) 98-2012

CATIA V5 (.CATPart, .CATProduct) R6 to R21

TABLE 2-1:  PRODUCTS FOR CAD INTEROPERABILITY ON WINDOWS

PRODUCT SUPPORTED FILE FORMATS REQUIRED PRODUCTS
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L I V E L I N K  F O R  S O L I D WO R K S

LiveLink for SolidWorks is compatible with SolidWorks 2011 and 2012.

L I V E L I N K  F O R  S P A C E C L A I M

LiveLink for SpaceClaim requires SpaceClaim 2011+ or 2012, and the Data Exchange 
II module available from SpaceClaim.

Parallel System Requirements

COMSOL 4.3 supports shared-memory parallelism and distributed-memory 
parallelism on 32-bit and 64-bit Windows. Distributed-memory parallelism requires 
Windows Compute Cluster Server 2003 with Service Pack 1, Windows HPC Server 
2008, or Windows HPC Server 2008 R2.

Internet Protocol Support

IPv4 and IPv6 are supported on all Windows platforms.
S Y S T E M  R E Q U I R E M E N T S  |  19
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I n s t a l l i n g  COMSOL

In this section:

• Before You Begin

• Installing COMSOL

• Cluster Installation

• Automated Installation

• Removing (Uninstalling) the COMSOL Installation

• Automated Removal (Uninstallation) of COMSOL

• Changing the Path to the MATLAB Installation

• Adding the LiveLink Interface to SolidWorks

• Adding the LiveLink Interface to Autodesk Inventor

• Changing the Path to the Pro/ENGINEER Installation

• Changing the Path to the Creo Parametric Installation

Before You Begin

• Check that the system meets all applicable requirements (see System Requirements 
for Microsoft Windows).

• Have the passcode or license file ready. A passcode has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

A passcode or a license file is required to install COMSOL 4.3. You should have 
received it in an email or letter from your sales representative. If neither a passcode nor 
a license file have been received, contact your local COMSOL representative. 

Some COMSOL license types require that a license manager is installed before running 
a COMSOL software product. If COMSOL software is installed with a passcode, no 
license manager is needed. If it is installed with a license file, you need to install the 
license manager if the license file contains a line starting with the word SERVER. See 
License Manager Installation for instructions. The COMSOL software products and 
the license manager can be installed in any order.
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Other COMSOL license types require a dongle (hardware lock). If you have received 
a dongle to use with the COMSOL software, please refer to dongle/readme.txt on 
the DVD for installation instructions.

An installation of earlier COMSOL versions on your computer is not affected by the 
COMSOL 4.3 installation except that double-clicking a Model MPH-file created with 
an earlier version of COMSOL will open in COMSOL 4.3. You can continue to use 
earlier versions or uninstall them independently of the COMSOL 4.3 installation.

Installing COMSOL

1 Insert the COMSOL DVD into the DVD drive. The COMSOL Setup window should 
appear automatically; if not, run the file setup.exe on the installation DVD. When 
the COMSOL 4.3 Installer window appears:

- Click New Installation and proceed to Step 2 to make a new installation.

- Click Add/Remove Features and proceed to Step 4 to change or repair an existing 
installation. For example, use Add/Remove Features when adding or removing 
documentation files for products installed or when adding or removing a product 
that your license includes.

- Click Change License and proceed to Step 2 to update the license of an existing 
installation. Use this option when COMSOL is installed and to get a new license 
file. The installer then removes features/products not licensed any more and lets 
you go through the Add/Remove Features procedure to add or remove features for 

In this guide, the term COMSOL 4.3 refers not only to COMSOL 
Multiphysics 4.3 but also to any other members of the COMSOL 
product line.Note
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the new license. If your trial license has expired you can use the Change License 
option to re-enable the old (paid) license.

- Click Uninstall COMSOL 4.3 to remove an existing installation.

Change the path to the existing installation by pressing the F1 key.
Tip
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2 After reading the license agreement, click the I accept the terms of the license 

agreement button and specify the license. Use one of the following license formats:

- Passcode: Enter your passcode, which is a series of characters and numbers that 
has a form similar to FFFFFFFF-TYUS-123456-1234567-123456789. The 
passcode is case sensitive.

- License file: Enter the path to an existing license file or click Browse to select the 
file license.dat.

- Port number and Host name: Enter the host name of an existing license server and 
its license server port number.

- Three-server redundancy: Enter the host names and license server port numbers of 
an existing three-server redundant configuration.

3 Click Next.

If Change License was selected in Step 1, you can choose to use an existing 
paid license or trial license, or you can choose to specify a new license. 
Click Next and proceed to Step 4 if you change the license to a license with 
different products. Otherwise, proceed to Step 9.Note
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4 On the Platforms page, you can typically accept the default settings

5 Click Next.
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6 Select the features to install and specify the path to the COMSOL installation 
directory.

Feature symbols:

7 Click Next.

not currently installed, will be installed

not currently installed, will not be installed

currently installed, will not be updated

currently installed, will be updated

currently installed, will be removed

If Add/Remove Features or Change License was selected in Step 1, the 
Features page includes a Repair all selected features check box.

Note
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8 Set the installation options:

- Create COMSOL shortcuts on the Windows Desktop

- Create COMSOL shortcuts on the Windows Start Menu

- Associate the COMSOL Multiphysics model file type (.mph files) with the 
COMSOL installation. If this option is selected, you can open COMSOL models 
by double-clicking them.

- Clear the Install DirectX runtime binaries check box if you previously experienced 
problems using DirectX on your computer.

- For the LiveLink products for MATLAB, Pro/ENGINEER, and Creo 
Parametric specify the path to the MATLAB, Pro/ENGINEER, and Creo 
Parametric installations. 

9 Click Next.
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10 When you click Install the utility now installs or updates COMSOL. The installation 
process might take several minutes. The Finish page in Step 9 appears automatically 
when the installation process is finished.

11 This window appears when the installation is finished. Click View Log to open a 
window that shows the installation log. Click Finish to quit the installer.
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Cluster Installation

The installation instructions above can be followed also for clusters, considering the 
following:

Make sure the head nodes has Windows HPC Server 2008 R2, Windows HPC Server 
2008, or Windows Compute Cluster Server 2003 with Service Pack 1 or later. If you 
have Windows HPC Server 2008 R2 on the head node, the compute nodes may run 
Windows HPC Server 2008 R2 or Windows 7 with the Windows HPC Pack. If you 
run Windows HPC Server 2008 or Windows Compute Cluster Server 2003 with 
Service Pack 1or later on the head node, the compute nodes must run the same 
operating system as the head node.

License manager   COMSOL requires a floating network license on clusters. Please 
check the license file for the CLUSTERNODE feature. The license manager needs to 
be accessible from all nodes in the cluster. Therefore it is often a good idea to have it 
run on the head node. See License Manager Installation on Windows.

Installation folder   The COMSOL installation folder should be shared between all 
compute nodes and the head node.

Features   During installation, make sure the Cluster Components feature is selected.

Access to Cluster   If you work on a desktop PC, install COMSOL on that PC. Before 
you start, you need to install Windows HPC Pack on the PC. This software is free and 
shipped with the Windows Server operating system and enables you to access the 
cluster from your PC.

Automated Installation

You can install COMSOL using an automated installation process with minimal user 
interaction. An answer file then responds to questions while the installer is running. 
The answer file is a text file with a specific format that contains predefined settings that 
the COMSOL installer uses. Start the installation by running

 <path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the path to your answer file. A template answer file, 
setupconfig.ini, with detailed usage information is available on the DVD.
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Removing (Uninstalling) the COMSOL Installation

To remove a COMSOL installation from your system, use the COMSOL Uninstaller. 

You can start the COMSOL Uninstaller in three ways:

• From the Windows Start Menu, open the Control Panel and select Uninstall a 

program. Find COMSOL 4.3 in the list and select uninstall.

• From the Windows Start Menu under COMSOL 4.3, select Uninstall COMSOL 4.3.

• By inserting the COMSOL DVD and starting the COMSOL Uninstaller. Click 
Uninstall COMSOL 4.3  to start removing the installation. Click Finish to quit the 
installer when the uninstallation is complete.

The uninstaller deletes all COMSOL 4.3 files and directories on the 
system that were installed by the COMSOL installer. Additional files and 
folders created after installation are not removed. 

If COMSOL Multiphysics is run with MATLAB, close MATLAB before 
starting the uninstaller. If MATLAB is active, the utility cannot remove 
certain files.

Note

Note
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Automated Removal (Uninstallation) of COMSOL

You can automatically uninstall COMSOL by running

<path to COMSOL>\bin\win32\comsoluninstall <path to COMSOL> -s

where <path to COMSOL> is the path to the COMSOL installation directory.

Alternatively, you can also uninstall COMSOL using an answer file. The 
documentation on how to create such an answer file is in the template answer file, 
setupconfig.ini, which is available on the DVD. When an answer file is created for 
uninstalling, you start the uninstallation by running

 <path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the path to your answer file.

Configuring Model Library Update

Using the preferences described under Updates in the section Editing Preferences 
Settings in the COMSOL Multiphysics User’s Guide you can configure proxy server 
settings as well as model and documentation directories for Model Library Update. See 
also Documentation and Model Library Root Directories for the related COMSOL 
options -docdir and -modelsdir.

Changing the Path to the MATLAB Installation

Change the path to the MATLAB installation in the user preferences you can access 
directly from the COMSOL Desktop. See the LiveLink products section in Editing 
Preferences Settings in the COMSOL Multiphysics User’s Guide.

Adding the LiveLink Interface to SolidWorks

If you have acquired LiveLink for SolidWorks, the COMSOL Installer adds an add-in 
to SolidWorks called the LiveLink for COMSOL (4.3). This add-in should appear in the 
SolidWorks user interface, listed in the Add-Ins dialog box, accessible from the Tools 
menu.

The connection between COMSOL and SolidWorks can fail if SolidWorks is installed 
after COMSOL or if you make manual changes to the Windows registry. In the case 
of such a failure, it is possible to set up the connection as follows:

1 Close SolidWorks if it is running on your computer.
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2 Click the Start menu symbol in the lower-left corner of your Windows desktop.

3 Enter cmd in the Start Search field.

4 cmd.exe appears in the list of programs. Right-click on it and select Run as 

administrator.

5 In the command window that appears enter one of the following, depending on 
your operating system:

- on 32-bit Windows:

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\SolidWorks\win32\
cslivelinksw.dll /codebase
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\SolidWorks\win32\
cscomactivex.dll /codebase

- on 64-bit Windows:

C:\WINDOWS\Microsoft.NET\Framework64\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\SolidWorks\win64\
cslivelinksw.dll /codebase
C:\WINDOWS\Microsoft.NET\Framework64\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\SolidWorks\win64\
cscomactivex.dll /codebase

In the above C:\Program Files\COMSOL\COMSOL43 is the local path to your 
COMSOL installation.

6 Open SolidWorks and on the Tools menu select Add-Ins.

7 In the Add-Ins dialog box that opens, make sure that the LiveLink for COMSOL (4.3) 
item is active by checking the appropriate check boxes.

Adding the LiveLink Interface to Autodesk Inventor

If you have purchased LiveLink for Inventor, the installer adds an add-in to Autodesk 
Inventor called the LiveLink for COMSOL (4.3). This add-in should appear in the Add-In 

Manager dialog box which is accessible from the Options tab of the Tools panel in the 
Autodesk Inventor user interface.

 Both commands need to be entered, and the complete command string 
must be written on a single row.

Important
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In case the connection between COMSOL and Autodesk Inventor fails, it is possible 
to set up the connection as follows:

1 Close Autodesk Inventor if it is running on your computer.

2 Click the Start menu symbol in the lower-left corner of your Windows desktop.

3 Enter cmd in the Start Search field.

4 cmd.exe appears in the list of programs. Right-click on it and select Run as 

administrator.

5 In the command window that appears enter one of the following, depending on 
your operating system:

- on 32-bit Windows:

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\Inventor\win32
\cslivelinkinv.dll /codebase

- on 64-bit Windows:

C:\WINDOWS\Microsoft.NET\Framework64\v2.0.50727\RegAsm.exe 
C:\Program Files\COMSOL\COMSOL43\ext\LiveLink\Inventor\win64\
cslivelinkinv.dll /codebase

In the above C:\Program Files\COMSOL\COMSOL43 is the local path to the 
COMSOL installation.

6 Open Autodesk Inventor and check that the add-in LiveLink for COMSOL (4.3) appears 
and is loaded in the Add-In Manager dialog box.

Changing the Path to the Pro/ENGINEER Installation

If you have acquired the LiveLink for Pro/ENGINEER, you need to provide the 
installation path for Pro/ENGINEER during the install process. After the installation 
you can configure the interface to work with a different Pro/ENGINEER installation. 
Edit the file comsol.ini in the bin/<platform> directory under the COMSOL 
installation directory (typically C:\Program Files\COMSOL\COMSOL43). In the file, 
change the line starting with

-Dcs.proeroot

 The complete command string must be written on a single row.
Important
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to point to the root directory of the Pro/ENGINEER installation, typically

-Dcs.proeroot=C:\Program Files\proeWildfire 5.0

or

-Dcs.proeroot=C:\Program Files\PTC\Creo Elements\Pro5.0

for an installation of Creo Elements/Pro.

If you have installed both the LiveLink for Pro/ENGINEER and the LiveLink for 
Creo Parametric, you can use only one of those during a COMSOL Multiphysics 
modeling session. The default is to connect to Creo Parametric. To connect to Pro/
ENGINEER locate the following line in the comsol.ini file

#-Dcs.useproe

and delete the # sign from the beginning of the line, then restart COMSOL. To 
connect to Creo Parametric again add the # sign to the beginning of the line

-Dcs.useproe

Changing the Path to the Creo Parametric Installation

If you have bought the LiveLink for Creo Parametric, you need to provide the path to 
the common files folder in the Creo Parametric installation during the install process. 
After the installation you can configure the interface to work with a different Creo 
Parametric installation. Edit the file comsol.ini in the bin/<platform> directory 
under the COMSOL installation directory (typically C:\Program Files\COMSOL43). 
In the file, change the line starting with

-Dcs.creoproot

to point to the common files directory of the Creo Parametric installation, typically

-Dcs.creoproot=C:\Program Files\PTC\Creo 1.0\Common Files\F000
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L i c e n s e  Manag e r  I n s t a l l a t i o n

In this section you will find information about:

• System Requirements

• Obtaining a FlexNet License File

• License Manager Installation on Windows

• Changing the License

• Obtaining a Hostid

The license manager supports a heterogeneous network of Windows, Linux, and Mac 
OS X computers. Both the license manager and a COMSOL application can run on 
either Windows, Linux, or Mac platforms. The computer where the license manager is 
installed is called the license server and any computer that has the COMSOL 
applications installed is called clients. COMSOL can be installed anywhere, typically 
on a local PC or on a file server where users access the program over a network. A 
single computer can function as a license server and a client, holding both the license 
manager and COMSOL. The COMSOL license manager does not require a MATLAB 
license manager.

The license manager and COMSOL can be installed in any order. A full test of the 
installation cannot be done until both are installed.

COMSOL uses the FlexNet™ license manager version 11 from Flexera Software, Inc. 
for license management.

System Requirements

Before starting the installation process, check that your system meets all necessary 
requirements. They are crucial for the COMSOL application, whereas the license 
manager only needs the correct hardware and operating system—for the license 
manager, memory and graphics requirements are not necessary. The COMSOL license 
manager is completely independent of the MATLAB license manager.

FlexNet was formerly called FLEXlm.

Note
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Obtaining a FlexNet License File

To install a COMSOL license manager requires a FlexNet license file, license.dat. 
It looks something like this:

#------------------------------------------------------------------
# COMSOL 4.2a FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
SERVER my_server 0050569e1b87 1718
USE_SERVER
VENDOR LMCOMSOL port=1719
FEATURE SERIAL LMCOMSOL 4.2 permanent uncounted \
    VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
    SIGN=0C3A8BF6722E
INCREMENT COMSOL LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT HEATTRANSFER LMCOMSOL 4.2 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLIENTSERVER LMCOMSOL 4.2 permanent 4 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLUSTERNODE LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=U \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC

In the license.dat file, the text on the SERVER line should contain the license server 
name <my_server>, the hostid of the license server, and an optional port number.

Confirm that the license server name is the actual name of your license server; 
otherwise, change it by editing the file. The default port number (1718) can also be 
changed in the unlikely case that another program is already using that port number. 
If the default port number is being used, change it to another number between 1025 
and 64,000.

A COMSOL license.dat file is shipped with the COMSOL package. If 
the file has not been received, contact your local COMSOL representative 
or send a request to support@comsol.com.Note
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The VENDOR line defines the name of the vendor daemon binary, LMCOMSOL.

The SERIAL line contains license information.

The INCREMENT (can also be FEATURE) lines contain a product name, version, 
expiration date, and the number of available licenses. The example file above shows 
that the user has a permanent COMSOL 4.2a license allowing four concurrent users 
of COMSOL Multiphysics and two concurrent users of the Heat Transfer Module. 
The number after “SIGN=” at the end of each INCREMENT line contains a license key. 
Long lines can be broken by a continuation character (\).

In the license.dat file has not been received, provide COMSOL with the hostid of 
your license server (for Windows, see Obtaining a Hostid, for Linux, see Obtaining a 
Hostid, and for Mac, see Obtaining a Hostid for instructions) and preferably the 
license server name. Have these ready when contacting your local COMSOL 
representative.

If the COMSOL license manager is running on a computer with an active 
firewall and the COMSOL Multiphysics client is outside of that firewall, 
at least two port numbers must be opened up in the license server’s 
firewall to allow client computers to connect to the COMSOL license 
manager. 

To implement this requirement, make sure the VENDOR line in the 
license.dat file reads VENDOR LMCOMSOL port=1719
(the number can be any unused port number in the allowed range). Then 
configure the firewall to allow access to the chosen port numbers (in the 
example above, 1718 and 1719). If you are unsure about which port 
numbers are free or how to enable firewall port access, contact your 
system administrator.

Do not modify anything in the license.dat file except license server 
name and (if necessary) port numbers or the license may not work.

Important

Caution
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License Manager Installation on Windows

You only need to install the license manager if you have obtained a license file that 
starts with a line that contains the word SERVER.

The license server requires these components:

• COMSOL license manager files (FlexNet)

• License file (license.dat)

F L E X N E T  C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of four components:

• License manager daemon (lmgrd.exe)

• Vendor daemon (LMCOMSOL.exe)

• FlexNet utility program (lmutil.exe)

• FlexNet Control Panel (lmtools.exe)

The two daemons (lmgrd.exe and LMCOMSOL.exe) run on the license server. When a 
user starts COMSOL on a client computer, communication is established through the 
network from the client to the license server and the lmgrd.exe daemon. That 
daemon in turn makes a request to the vendor daemon (LMCOMSOL.exe), which 
releases licenses according to information in license.dat. The utility program and 
Control Panel handle license-server management. For more information, select 
Help>Documentation from the main menu, and scroll to the bottom of the page to 
locate a PDF copy of the FlexNet Licensing End Users Guide (see Chapter 7).

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S

Install the license manager only on the host(s) listed in license.dat.

If you want to install COMSOL on the same host as the license manager, first perform 
a complete COMSOL installation because that procedure installs the license manager 
files along with COMSOL. See Installing COMSOL for installation instructions. 
When finished, skip the remainder of this section and continue with Starting the 
License Manager.

To install only the COMSOL license manager files, follow these instructions:

1 Insert the DVD into the DVD drive.

2 Follow the installation instructions starting with Installing COMSOL until you 
reach the Features screen in Step 4.
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3 In the list of products to install, select only the License Manager check box.

4 Continue from the Features screen in the installation instructions to complete the 
license manager file installation.

Automated License Manager Installation
Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction. See the section Automated Installation. Set 
licmanager = 1 in the answer file to install the license manager. 

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

The license manager can be started manually, or it can run automatically as a service at 
boot.

Starting the Manager Automatically as a Service
To set up the license manager as a service from the FlexNet Control Panel:

1 Locate the COMSOL43\license\win32 (32-bit Windows) or 
COMSOL43\license\win64 (64-bit Windows) directory and run lmtools.exe.

2 On the Service/License File page choose Configuration using Services. 

3 Click the Configure Services tab.

4 Make an entry in the Service Name field, for example, COMSOL License Manager.

5 Specify the full path to lmgrd.exe, license.dat, and the debug log file name of 
your choice.

This step must be done every time the FlexNet Control Panel is started.
Important
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6 Select the Use Services check box (this might not be possible on all platforms, but it 
is recommended) and then the Start Server at Power Up check box.

7 Click Save Service. The license manager now starts at boot. If you prefer, start the 
license manager directly by choosing Start Server on the Start/Stop/Reread page.

Starting the Manager Manually
To start the license manager manually, change to the license\win32 (Windows) or 
license\win64 (64-bit Windows) directory. Now, in a command window enter

lmgrd -c ..\license.dat -l ..\comsol43.log

The license manager is now ready to distribute licenses over the network. It writes 
debug information to the log file COMSOL43\license\comsol43.log.

S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s), you can start using COMSOL.
L I C E N S E  M A N A G E R  I N S T A L L A T I O N  |  39



40 |  C H A P T E R
Changing the License

If you have received a new license file—for example, when adding COMSOL products 
to an existing license—replace the current license file with the new one. Double-check 
the contents of this file to make sure it lists the products that the license includes.

R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R

To restart the license manager, follow these steps:

1 In the Windows Start menu, choose COMSOL4.3>License Tools>LMTOOLS.

2 In the FlexNet Control Panel, click, in turn, Stop Server, ReRead License File, and 
Start Server.

Obtaining a Hostid

If COMSOL is already installed on the license server, determine the hostid by 
executing the lmhostid command

COMSOL43/license/$arch/lmhostid

where $arch is win32 (32-bit Windows) or win64 (64-bit Windows).

If COMSOL is not installed, obtain a hostid using the: ipconfig /all command on 
the license server.

All machine architectures use an Ethernet address (also called a MAC address) as the 
hostid. An Ethernet address has six bytes, each with two hexadecimal digits. Be sure to 
specify all twelve hex digits when using an Ethernet address as a hostid. For example, 
if the Ethernet address is 8:0:20:0:5:ac specify 0800200005ac as the hostid.

O B T A I N I N G  T H E  H O S T I D

1 Open the Start menu and click Run.

2 Enter cmd and click OK and the command window opens.

3 Enter 

  ipconfig /all

and press Enter.

When the license file has changed, you must restart the license manager; 
otherwise, it continues to use the old license file still in memory.

Important
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4 The FlexNet hostid is equal to the Physical Address, which is displayed in the next 
image, with the hyphens removed. For example, 00-11-25-AC-C9-03 becomes the 
hostid 001125ACC903.
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T r oub l e s h oo t i n g  L i c e n s e  E r r o r s

This section summarizes the most common post-installation error messages generated 
by COMSOL, and it gives some advice how to troubleshoot them. Also check the 
COMSOL Support Knowledge Base at www.comsol.com/install for up-to-date 
information about installation and license issues.

TABLE 2-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, send the complete error message to 
support@comsol.com.

License error: -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

C:\Program Files\COMSOL43\license\comsol43.log

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

NOTE: The license manager creates the log file. If there is no log 
file, make sure to first start the license manager. Please refer to the 
section License Manager Installation for instructions how to 
install and start the COMSOL license manager. 

License error: -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com. The log file is usually placed here:

C:\Program Files\COMSOL43\license\comsol43.log
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License error: -15. 
Cannot connect 
to license server 
system.

The COMSOL license manager has not been installed or started 
yet. If the first line of your license.dat file looks like this:

   SERVER mylicserver 000123456789 1716

a license manager is required. Please refer to the section License 
Manager Installation for instructions how to install and start the 
COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client 
computer points to the correct license server hostname. First, find 
the license.dat file in the COMSOL application folder:

C:\Program Files\COMSOL43\license\license.dat

Check that the first line has the correct license-server hostname. 
For example, if your license server hostname is mylicserver, the 
first row in the license.dat file should look like this:

   SERVER mylicserver 000123456789 1716

If the COMSOL client computer does not recognize 
mylicserver as a proper hostname, it might help to instead use 
the fully qualified domain name (mylicserver.mydomain.org) 
or the IP address. If neither of these work, there might be a 
problem with DNS or the HOSTS file on the client. Please ask 
your system administrator for advice on how to connect with 
TCP/IP to the license server.

Finally, the license manager might have encountered a problem 
during startup. Check the license manager log file for error 
messages. The log file is usually placed here:

C:\Program Files\COMSOL43\license\comsol43.log

NOTE: The log file is created by the license manager after it has 
been started.

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

TABLE 2-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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License error: -39. 
User/host not on 
INCLUDE list for 
feature.

This error can only occur for the Named Single User License 
(NSL) license type. The error means that your username does not 
match the one listed in the license-manager options file, 
LMCOMSOL.opt. To get access to COMSOL, ask your license/
system administrator for help. When the username in the options 
file is changed, the license manager must be shut down and 
restarted to give the new user immediate access to COMSOL. 

License error: -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current 
local time and date. If the problem remains check that there are no 
files on your hard drive that are dated in the future.

License error: -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER hostname in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

The license.dat file is located in the COMSOL application 
folder:

C:\Program Files\COMSOL43\license\license.dat

License error: -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

C:\Program Files\COMSOL43\license\comsol43.log

NOTE: The log file is created by the license manager after it has 
been started. 

Please send the log file to support@comsol.com if you want help 
in interpreting the information. 

TABLE 2-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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Runn i n g  COMSOL

The installer adds the folder COMSOL 4.3 to the Start menu under the Programs item. 
That folder contains a selection of the items in the following list depending on the 
licensed COMSOL software products you have:

- COMSOL Multiphysics: Opens COMSOL Multiphysics. A corresponding shortcut 
is added to the desktop.

- COMSOL with MATLAB: Starts MATLAB R2012a/R2011b and sets up all necessary 
paths. Also starts a COMSOL server connected to MATLAB. A corresponding 
shortcut is added to the desktop.

- COMSOL Multiphysics Server: Starts a COMSOL Multiphysics server that a 
COMSOL Multiphysics client can connect to.

- Documentation: A folder that contains COMSOL documentation shortcuts.

In this section:

• Running COMSOL Multiphysics

• Running COMSOL on Multicore and Multiprocessor Computers

• Running a Classkit License

• Running COMSOL in Batch Mode

• Running COMSOL on Clusters

• Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics

You can run COMSOL Multiphysics by double-clicking the COMSOL Multiphysics 4.3 
icon on the desktop.

Alternatively, to activate COMSOL Multiphysics from the Start menu, point to 
Programs, then to COMSOL 4.3, and then click COMSOL Multiphysics.
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Running COMSOL on Multicore and Multiprocessor Computers

By default, a COMSOL process uses all cores and all processors on your computer 
using shared-memory parallelism. It uses the system environment variable 
NUMBER_OF_PROCESSORS  to determine the number of available cores and processors. 

Running a Classkit License

The COMSOL installation program automatically installs a shortcut on the desktop 
that launches COMSOL using your classkit license.

Running COMSOL in Batch Mode

You can submit COMSOL batch jobs from the COMSOL Desktop and the command 
line. In the Model Builder, right-click on a Study node and select Batch to create batch 
jobs.

Running COMSOL on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the command 
line. To run COMSOL on a cluster, you need to make the cluster feature visible: click 
the Show button ( ) and select Advanced Study Options. Then in the Model Builder, 
right-click a Study node and select Cluster Computing to create cluster jobs.  

To override this behavior, see Shared-Memory Options.

Note

For command-line options, see COMSOL Batch Commands.
See Also

Cluster computing requires an FNL (floating network) license.

Note
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Running COMSOL Multiphysics with MATLAB

To run COMSOL Multiphysics with MATLAB, double-click the 
COMSOL 4.3 with MATLAB icon on the desktop.

Alternatively, start COMSOL Multiphysics with MATLAB from the Start menu by 
pointing to Programs, then to COMSOL 4.3, and then select COMSOL 4.3 with MATLAB.

For more information about how to run COMSOL in parallel on 
Windows clusters, see Running COMSOL in Parallel in the COMSOL 
Multiphysics User’s Guide 

For command-line options, see COMSOL Cluster Commands.
See Also

Running COMSOL Multiphysics with MATLAB starts a COMSOL 
server and a MATLAB Desktop. The COMSOL Desktop is not involved. 
For tutorial on using the LiveLink interface for MATLAB, see the 
Introduction to the LiveLink for MATLAB.

Running COMSOL Multiphysics with MATLAB requires a LiveLink for 
MATLAB license.

Tip

Note
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Th e  COMSOL Command s

Use a COMSOL command to start COMSOL products with detailed start-up options.

The general syntax of the COMSOL commands is

<command> [<target>] [<options>] [<target arguments>]

where square brackets indicate optional arguments. On windows there are several 
different commands (See <command> in the command syntax) that can be combined 
with optional targets to achieve various results. The table below lists the major available 
commands and targets.:

The commands are available in 32-bit versions in the subdirectory bin\win32 in the 
COMSOL installation directory, and in 64-bit versions in the subdirectory bin\win64 
in the COMSOL installation directory. The COMSOL installer sets up a few of the 
possible commands on your start menu and your desktop. To create additional 

TABLE 2-4:  COMSOL COMMANDS TARGETS

COMMAND AND TARGET DESCRIPTION AVAILABILITY

comsol Run standalone 
COMSOL Multiphysics

comsolserver Start COMSOL 
Multiphysics server

comsol client Run COMSOL 
Multiphysics client

comsolbatch Run a COMSOL 
MPH-file or class file

comsolcompile Compile a Model 
Java-file

comsolcluster Run COMSOL Desktop 
on a cluster

Requires a floating 
network license (FNL)

comsolclusterbatch Run COMSOL cluster 
version in batch mode

Requires a floating 
network license (FNL)

comsolclusterserver Run COMSOL cluster 
server 

Requires a floating 
network license (FNL)

comsolserver matlab Start MATLAB and 
connect to a COMSOL 
server

Requires a LiveLink for 
MATLAB license

comsol convertpre35a Convert 3.0–3.5 models
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customized commands, you can create shortcuts including all argument and put them 
on your desktop. You can also issue COMSOL commands in a command window. To 
conveniently access the command in a command window, you need to set up the 
Windows path to include one the paths bin\win32 or bin\win64 in the COMSOL 
installation directory.

I N I  F I L E S

For each launcher file, there is a corresponding .ini file in the same directory. It is 
sometimes recommended that these files are edited. For example, you can add options 
to any of the above commands by modifying the corresponding ini file.To change the 
option opt to value val, add the line

-Dopt=val

to the file comsol.ini. Change the file comsolbatch.ini for comsolbatch, and 
similarly for the other COMSOL targets.

O P T I O N S

You can enter various options after the COMSOL command and target. Table 2-5 lists 
the options (See [<options>] in the command syntax) available for all COMSOL 
commands. Always issue these options between the command and the target (if any).

TABLE 2-5:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE

-h Print general help

<target> -h Print target-specific help

-3drend ogl | dx9 | sw 3D renderer: OpenGL, 
DirectX, or software 
rendering

-docroot <path> Specify custom path to 
the COMSOL 
documentation root 
directory.

See Documentation and 
Model Library Root 
Directories

-modelsroot <path> Specify custom path to 
the COMSOL Model 
Library root directory.

See Documentation and 
Model Library Root 
Directories

-np <no. of processors> Number of processors See Shared-Memory 
Options

-numasets <no. of sets> Number of NUMA sets See Shared-Memory 
Options
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For the -tmpdir option, COMSOL software uses the specified directory to store 
temporary files. The -prefsdir option specifies the directory where COMSOL 
should store the preference file.

Documentation and Model Library Root Directories
In a default COMSOL installation, the documentation files are located in the directory 
doc under the installation root directory. You can use the -docroot option if you want 
to move the documentation directory to a different location. Similarly, use the 
-modelsroot option if you want to move the Model Library root directory models 
from its default location under the COMSOL installation root. Relocating the 
documentation and Model Library root directories can be useful for administering 
Model Library Update; see Configuring Model Library Update.

Shared-Memory Options
Use the option -np to control the number of core and processors used. The default is 
to use all available cores and processors.

Use the option -numasets to control the number of Non-Uniform Memory Access 
node sets COMSOL should take into account. This is usually the number of processor 
sockets that the hardware is using.

-mpmode throughput | 
turnaround | owner

Multiprocessor mode See Shared-Memory 
Options

-blas {auto} | mkl | acml | 
path

BLAS library to use See BLAS Options

-blaspath <path> BLAS library path See BLAS Options

-ipv6 Activate IPv6 support

-prefsdir <path> Preference directory

-tmpdir <path> Temporary file directory

-version Print COMSOL version

-version <target> Print target version

-ckl Use class-kit license

-autosave {on} | off Control saving of 
recovery files

-recoverydir <path> Path to recovery 
directories

TABLE 2-5:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE
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Depending on how loaded the machine is, you can control how COMSOL uses the 
available processors. The following options are available:

You may need to experiment to find the options that work best for your configuration.

BLAS Options
BLAS is a set of functions for basic linear algebra operations. A large portion of the 
computational engine in COMSOL relies on BLAS. COMSOL provides for the 
following BLAS related options:

Both MKL and ACML are distributed along with COMSOL.

If you want to use a different BLAS library than the default, make sure that COMSOL 
can find the library. The simplest way for COMSOL to find a library is to put it in /
lib/ARCH where ARCH is the architecture (win32 or win64) or somewhere in the 
standard search path. Also provide the path to any sub-libraries needed by the library. 
Set the search path to point to the directory where the library is installed. To do so, 
use the environment variable PATH.

TABLE 2-6:  COMSOL MULTIPROCESSOR MODE OPTIONS

MPMODE OPTION DESCRIPTION

throughput Is expected to give the best performance when several different 
processes are running actively at the same time as COMSOL.

turnaround Typically provides the best performance when no other processes than 
COMSOL are active.

owner Provides the highest performance in most cases.

TABLE 2-7:  COMSOL BLAS OPTIONS

BLAS OPTION DESCRIPTION

auto Determine BLAS library automatically: MKL for Intel processors, and 
ACML for AMD processors with SSE2 support, otherwise MKL. (This is 
the default option.)

mkl Use the Intel MKL library.

acml Use the AMD ACML library.

path Use a BLAS library specified using the option -blaspath or the 
environment variable COMSOL_BLAS_PATH. The library must support 
the standard FORTRAN BLAS interface.
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C O M S O L  C O M M A N D S

In additions to the options in Table 2-5, the standalone COMSOL command supports 
the following option.

C O M S O L  S E R V E R  C O M M A N D S

Use a COMSOL server command to start a COMSOL process ready to process 
computational requests. A COMSOL server listens for TCP/IP connections from 
COMSOL clients. A COMSOL Desktop can become a COMSOL client by 
connecting to a COMSOL server. The LiveLink interface for MATLAB also needs to 
connect to a COMSOL server.

The Windows syntax for the COMSOL server command is

comsolserver [<options>] [<target arguments>]

The following target arguments are available for a COMSOL server command.

Accessing the COMSOL Server Computer
The server computer can be accessed in several ways. If it is dedicated to a single 
person, you can sit down at that machine and log in on it. You can also connect to the 
server computer by using Remote Desktop. Start the COMSOL server from the Start 

TABLE 2-8:  COMSOL COMMAND-LINE ARGUMENTS

COMSOL OPTIONS DESCRIPTION

-open <file> Open file

TABLE 2-9:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL SERVER OPTION DESCRIPTION

-user <user> Specify login name for a user

-port <port> Specify a TCP/IP port to listen for connect 
attempts.

-passwd reset|nostore Specify that you want to provide a new 
password.To avoid storing the new password on 
file use nostore

-login {info}|force|never Ask for login information. info means that only 
missing information is asked for.

-multi on|{off} Accept repeated client connections

-silent Do not listen to standard input

-graphics Start the server with graphics libraries. This 
displays plots on the server when you are 
connected with a client (that is, not with the 
COMSOL GUI).
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menu. If several people want to access a single Windows computer to run the 
COMSOL server, you must use Windows Terminal Server or another tool that allows 
multiple users to log in on the same Windows server. In some Windows versions, 
Microsoft provides a Telnet Server with which you can log in through a terminal 
window. When using a terminal window to log in on Windows, use the comsolserver 
command to start the COMSOL server.

Login Information
When a COMSOL Multiphysics server is started for the first time, you are asked for a 
user name and password. Select a user name and a password, which COMSOL 
Multiphysics then uses in communications between the COMSOL Multiphysics client 
and the server. You must also specify a matching user name and password in the 
Connect to Server dialog box. The software writes this login information in the 
subdirectory .comsol/v43/login.properties in your Windows home directory.

Client/Server Security Issues
COMSOL Multiphysics can operate in a client/server mode where COMSOL 
Multiphysics runs as a separate client and a server. COMSOL Multiphysics uses a 
TCP/IP connection to send data between the server and the client.

Once a COMSOL Multiphysics server is started, a person with access to your login 
information could potentially connect to your COMSOL Multiphysics server. When a 
COMSOL Multiphysics client connects or disconnects from a remote computer, the 
COMSOL Multiphysics server displays a message. The connection from the client to 
the server is made with the TCP protocol.

The server and client are mutually authenticated using a challenge handshake 
authentication protocol, which means that login information cannot be easily obtained 
by someone eavesdropping on the network communication. The TCP connection 
between the client and the server is otherwise not encrypted. If you require encryption 

Always make sure that untrusted users cannot access the COMSOL login 
information. Protect the file .comsol/v43/login.properties in your 
home directory. This is important when running COMSOL Multiphysics 
in client/server mode. Alternatively, start the COMSOL server with the 
-passwd nostore option, and clear Remember Password when 
connecting to the server. This ensures that your login information is not 
stored on file.

Important
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of the TCP connection, you can use third-party software based on protocols such as 
SSH or IPSEC.

C O M S O L  C L I E N T  C O M M A N D S

Use a COMSOL client command to start a COMSOL Desktop with a the Connect to 
Server dialog box open. 

The syntax for the COMSOL client command is

comsol [<options>] client [<target arguments>]

The following target arguments are available for a COMSOL client command.

C O M S O L  B A T C H  C O M M A N D S

Use the COMSOL batch command to run COMSOL jobs without a GUI. Run both 
Model MPH-files and Model Java-files with the COMSOL batch command. Model 
Java-files need to be compiled before running.

The Windows syntax for the COMSOL batch command is

comsolbatch [<options>] [<target arguments>]

Its detailed target arguments are:

TABLE 2-10:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL CLIENT OPTIONS DESCRIPTION

-port <port> Specify a TCP/IP port to connect to

-server <server name> Specify server to connect to

-open <file> Open file

TABLE 2-11:  COMSOL BATCH-SPECIFIC ARGUMENTS

COMSOL BATCH TARGET ARGUMENTS DESCRIPTION

-inputfile <file name> Run a Model MPH-file or class file

-outputfile <file name> Save a Model MPH-file using the given file 
name. If output is not given, the input file is 
overwritten with the output

-job <job tag> The batch job to run

-study <study tag> The study to compute

-pname <parameter name> Comma-separated list of parameter names

-plist <parameter value> Comma-separated list of parameter values

-batchlog <file name> File to store log in

-client Run as client
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Example
To use the COMSOL Batch mode to solve a model, run the following command:

comsolbatch -inputfile in.mph -outputfile out.mph -job b3 -pname v -plist 10

This command starts COMSOL Batch, solves the model in the Model MPH-file with 
the given file name using the active solver settings in the model, and stores the solution 
in the out.mph.

T H E  C O M S O L  C O M P I L E  C O M M A N D

The COMSOL compile command compiles a Model Java-file for use by the COMSOL 
batch command or for loading class files into the GUI. The Windows syntax for the 
COMSOL compile command is

comsolcompile [<options>] [<target arguments>] <file>.java

The Java file is mandatory. The following optional target arguments are available‘

C O M S O L  C L U S T E R  C O M M A N D S

All COMSOL cluster commands require a floating network license.

The Windows syntax for the COMSOL cluster command is

mpiexec -n <no. of nodes> <command> [<options>] [<target arguments>]

-host Connect to host

-port Connect to port

-graphics Start COMSOL batch with graphics 
libraries. This displays plots during analysis. 

-nosave Do not save the resulting model

TABLE 2-12:  COMSOL CLUSTER TARGET ARGUMENTS

COMSOL COMPILE TARGET ARGUMENTS DESCRIPTION

-jdkroot <path> Path to the JDK root

-classpathadd <classpath> Additional classpath

-verbose Verbose output

TABLE 2-11:  COMSOL BATCH-SPECIFIC ARGUMENTS

COMSOL BATCH TARGET ARGUMENTS DESCRIPTION
T H E  C O M S O L  C O M M A N D S  |  55



56 |  C H A P T E R
The following cluster commands are available:

The preferred way of starting COMSOL jobs is from the Job Configurations node in 
the COMSOL Desktop.

If you need to start COMSOL cluster jobs from the command line, the preferred way 
is to use the comsolclusterbatch command since the comsolclusterserver and 
comsolcluster commands require TCP/IP access from your client computer to the 
cluster node where COMSOL runs.

The Windows Configuration
• Make sure that Windows HPC Server 2008 or Windows Compute Cluster Server 

2003 is installed. Running distributed COMSOL on other Windows versions is not 
supported.

• Make sure that the Windows HPC Server 2008 working directory is set to point to 
the comsol command directory (<path to COMSOL install 
directory>\bin\win64). The install directory must be shared between the nodes 
on your cluster.

• Also make sure that the Microsoft Visual Studio 2010 and 2008 Runtimes are 
installed on all nodes. They are called vcredist_*.exe. You can install them from 
the root directory of the DVD using the clusrun command for instance.

• Also make sure that all nodes that you intend to run COMSOL on have access to 
the license manager and that you can start COMSOL running in nondistributed 
mode. The nodes require access to the license manager in order to check out 
licenses.

Example of the COMSOL Batch Command
Schedule a job with the command

TABLE 2-13:  COMSOL CLUSTER TARGETS

COMSOL CLUSTER COMMANDS DESCRIPTION

comsolclusterbatch Run COMSOL on a cluster in batch mode

comsolclusterserver Run COMSOL server on a cluster

comsolcluster Run COMSOL Desktop on a cluster 

Micromixer—Cluster Version: Model Library path COMSOL_Multiphysics/

Tutorial_Models/micromixer_cluster
Model
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mpiexec -n -1 comsolclusterbatch.exe -np 2 -inputfile <filename>

to run a COMSOL batch on a number of computational nodes given by mpiexec. For 
further information about the mpiexec command and Windows HPC Server 2008, 
consult the documentation that was shipped with the product and the online manuals.

Example of the COMSOL Server Command
When a COMSOL server cluster job is created, a preference directory must be set and 
be reachable from all nodes to avoid problems with the server login; see The 
COMSOL Commands and Login Information. The preferences can be generated by 
starting COMSOL server once on the head node using the command

comsolserver.exe -prefsdir <prefsdir>

where <prefsdir> is a preference directory common to all nodes.

When the COMSOL server is started on the cluster, the port number is written to 
standard output, so a standard output file and a standard error file must be set for the 
cluster job. To start a COMSOL server, schedule a job with the following command:

mpiexec -n -1 comsolclusterserver.exe -np 2 -prefsdir <prefsdir>

The argument -1 indicates that the number of computational nodes is decided at the 
mpiexec launch. You must be able to access the cluster node where the COMSOL 
server runs from the COMSOL client computer.

COMSOL MPI Options
The COMSOL cluster target arguments specify what MPI library to use and what 
Scalapack version to use. There are several implementations of MPI. COMSOL by 
default uses the Windows HPC Server 2008 or Windows CCS 2003 MPI libraries. 
COMSOL also supports most MPI implementations based on MPICH2. It is 
recommended that the default library is used. COMSOL also has a compatibility mode 
that is activated by adding the option -mpi mpich2. When using this option both the 
variables PATH and LD_LIBRARY_PATH must include the MPI implementation. It is also 
possible to use other MPI libraries based on MPICH2 using the option -mpipath 
<path to shared library>. The following target arguments are available for a 
COMSOL cluster commands.

TABLE 2-14:  COMSOL CLUSTER TARGET ARGUMENTS

COMSOL BATCH TARGET ARGUMENTS DESCRIPTION

-mpi {auto} | mpich2 | wccs2003 | 
whpc2008 | user | path

MPI library to use

-mpipath <path> MPI library path
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The Cluster Computing study allows you to set up a batch job for submission to a 
Windows HPC Server 2008 job scheduler or Windows Compute Cluster Server 2003 
job scheduler. There are several settings that you can configure in the comsol.ini file 
to get default settings:

-Dcs.scheduler=<IP or network adress> 
-Dcs.clusteruser=<Username on cluster>
-Dcs.rundir=<Where the model file is located on the cluster>
-Dcs.comsoldir=<Installation path to comsol on the cluster>

Additionally you can configure the commands:

-Dcs.precmd=<Command line> 
-Dcs.postcmd=<Command line> 

This adds commands prior to the comsol command and after the comsol command. 
You can add {nn} or {perhost} to any of these pre- or postcommands. This 
configures the Cluster Computing study to use the number of nodes and number of 
nodes on each host from the corresponding settings for the Cluster Computing study. 
For more information see the documentation for the Cluster Computing study in the 
COMSOL Multiphysics Reference Guide.

C O M S O L  M AT L A B  C O M M A N D

Use the COMSOL MATLAB command to access the COMSOL Java API through 
MATLAB. Type:

comsolserver matlab.

which launches a COMSOL server in a console window, starts MATLAB, and 
connects MATLAB to the COMSOL server.

The following options are available for the comsolserver matlab command:

-scalapack {auto} | mpich2 | 
wccs2003 | whpc2008 | user | path

Scalapack library to use

-scalapackpath <path> Scalapack library path

TABLE 2-15:  COMSOL MATLAB OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-mlroot <path> MATLAB installation directory

-host <hostname> Connect to host

-port <hostname> Connect to port

-desktop Start with Desktop

TABLE 2-14:  COMSOL CLUSTER TARGET ARGUMENTS

COMSOL BATCH TARGET ARGUMENTS DESCRIPTION
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C O M S O L  C O N V E R T P R E 3 5 A  C O M M A N D

Use the comsol convertpre35a command to convert a directory with models made 
in COMSOL 3.0–3.5 to COMSOL 3.5a. To use the command, enter

comsol [<options>] <input directory> <output directory> [log_file]

where <input directory> is the input directory, <output directory> is the output 
directory, and [log_file] is an optional log file. If the third argument is not 
provided, the log is printed on standard output.

-nodesktop Start without Desktop

-mlnosplash Start without MATLAB splash screen

-graphics Start the server with graphics libraries. This 
enables plotting on the server. Available 
only when running comsolserver 
matlab [<options>].

TABLE 2-16:  COMSOL CONVERTPRE35A OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-c35aroot <path> Installation path of COMSOL 3.5a

TABLE 2-15:  COMSOL MATLAB OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION
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I n s t a l l i n g  a n d  R u n n i n g  o n  L i n u x
This chapter provides detailed instructions for installing and running the 
COMSOL software on Linux. You also find complete system requirements and 
license manager information. For most installations, the COMSOL Quick 
Installation Guide  that comes bundled with the DVD provides the basic 
instructions for installation on Linux. See also the COMSOL Support Knowledge 
Base on www.comsol.com/install for specific troubleshooting tips.

• System Requirements

• Installing COMSOL

• License Manager Installation

• Troubleshooting License Errors

• Running COMSOL

• The COMSOL Commands
 61
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S y s t em Requ i r emen t s

In this section:

• COMSOL Multiphysics System Requirements for Linux

• LiveLink for MATLAB Requirements

• Products for CAD Interoperability

• Parallel System Requirements

• Internet Protocol Support 

COMSOL Multiphysics System Requirements for Linux

S Y S T E M  R E Q U I R E M E N T S — 3 2 - B I T  L I N U X

• GNU C Library version 2.3.6 or later

• Linux kernel 2.6.18 or later

• Intel Pentium IV or AMD Athlon processor or later.

S Y S T E M  R E Q U I R E M E N T S — 6 4 - B I T  L I N U X

• GNU C Library version 2.3.6 or later

• Linux kernel 2.6.18 or later

• A PC with one of these processors: AMD with AMD64 or Intel with EM64T.

For the most current system requirements, see 
www.comsol.com/products/requirements/

Note

.
See Also
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O F F I C I A L L Y  S U P P O R T E D  L I N U X  D I S T R I B U T I O N S

The following Linux distributions are officially supported by COMSOL:

G R A P H I C S  S Y S T E M  R E Q U I R E M E N T S

Prefer hardware rendering for performance reasons. Drivers supporting OpenGL 
version 1.4 are required. For using the Optimize for Quality setting in graphics 
preferences you need OpenGL 2.0. Prefer using drivers from you graphics card vendor. 
Alternatively, use software rendering; see Options. The Nouveau video driver is only 
supported for software rendering. Hardware rendering requires at least 24-bit color 
graphics. Software rendering also supports 16-bit color graphics.

LiveLink for MATLAB Requirements

LiveLink for MATLAB is compatible with MATLAB 2012a and 2011b.

The xterm program is necessary for the command comsol server matlab. The csh 
program is needed to call MATLAB functions from COMSOL.

To install the missing packages on Debian and Ubuntu, type

sudo apt-get install xterm csh

To install the missing packages on RedHat Enterprise and Fedora, type

sudo yum install xterm tcsh

To install the missing packages on OpenSUSE, type

sudo zypper install xterm tcsh

PLATFORM DISTRIBUTION

32-bit Linux Debian 5.0, 6.0, OpenSUSE 11.3, RedHat Enterprise 5a and 6,
Ubuntu 10.04 LTS

a. RedHat Enterprise 5 is only supported for server, batch, and cluster operation.

64-bit Linux Debian 5.0, 6.0, OpenSUSE 11.3, RedHat Enterprise 51 and 6,
Ubuntu 10.04 LTS

The programs xterm and csh are required.

Note
S Y S T E M  R E Q U I R E M E N T S  |  63



64 |  C H A P T E R
Products for CAD Interoperability

The following products support import of 3D CAD files on Linux platforms:

See Table 3-2 for detailed version information on the supported file formats.

Parallel System Requirements

COMSOL 4.3 supports shared-memory parallelism and distributed-memory 
parallelism for 32-bit and 64-bit Linux. For distributed-memory parallelism, 
COMSOL 4.3 supports Red Hat Enterprise Linux 5 and 6, and all computers in the 
cluster must use the same Linux version and should have similar hardware.

Internet Protocol Support

IPv4 and IPv6 are supported on all Linux platforms.

TABLE 3-1:  PRODUCTS FOR CAD INTEROPERABILITY ON LINUX

PRODUCT SUPPORTED FILE FORMATS REQUIRED PRODUCT

CAD Import Module ACIS (SAT), IGES, Parasolid, 
Pro/E, and STEP

COMSOL Multiphysics

TABLE 3-2:  3D CAD FILE FORMATS SUPPORTED BY COMSOL PRODUCTS ON LINUX.

FILE FORMAT (FILE EXTENSION) SUPPORTED VERSION

Parasolid (.x_b, .x_t) up to V22

ACIS or SAT (.sab, .sat) up to R21

STEP (.step, .stp) AP203, AP214

IGES (.iges, .igs) up to 5.3

Pro/ENGINEER (.prt, .asm) 16 to Wildfire 5

Creo Parametric (.prt, .asm) 1.0

To import ACIS, SAT, STEP, IGES and Pro/ENGINEER files on a 
64-bit linux system, the system must be able to run 32-bit programs.

Note
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I n s t a l l i n g  COMSOL

In this section:

• Before You Begin

• Installing COMSOL

• Cluster Installation

• Removing (Uninstalling) the COMSOL Installation

• Automated Installation

• Changing the Path to the MATLAB Installation

Before You Begin

Check that you have a license file license.dat, which you should have received by 
email. If you have not received a license file, contact your local COMSOL 
representative.

The license manager must be installed and started before running a COMSOL 
software product with the exception of trial licenses, which do not require a license 
manager. See License Manager Installation for instructions. You can install your 
COMSOL software products and the license manager in any order.

The installation program is an X-Windows application and needs access to an 
X-Windows display to run. Make sure that your DISPLAY variable is set up correctly 
and that you have access to an X-Windows display. Try the command xclock to test 
that the X-Windows display is working properly. To install your COMSOL software 
products in a system directory such as /usr/local, you might need to run the 
installation program as the root user. The COMSOL installer for Linux does not 
modify any files on your system outside the COMSOL installation directory.

Installing COMSOL 

1 Insert the COMSOL 4.3 DVD into the DVD drive.

2 If the DVD is not mounted automatically by your operating system, use the mount 
command to mount it.

3 To start the installation, enter the command
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sh drivepath/setup

where drivepath  is the mount point of the DVD drive, for example,
/media/cdrom.

You may have to mount the DVD with the option -o exec if your Linux mounts 
the DVD without execute options by default.

4 When the installer window appears, click New Installation.

5 Read the license agreement, select I accept the terms of the license agreement, specify 
License information, and then click Next.

6 Select the platforms that you want to install and click Next.

7 Select the features to install and specify the path to the COMSOL installation 
directory. 

8 Click Next.

9 Specify the MATLAB root folder. MATLAB versions 2012a and 2011b work with 
COMSOL 4.3.

10 Click Next.

11 Click Install to start the installation.

12 When the installation process is finished the Finish window appears. If errors arose 
during installation, this window issues a notification. The installer also writes a log 
entry into the text file comsolsetup.log, which resides in the specified installation 
directory. Click Finish to quit the installer. Use the unmount and eject commands 
to unmount and eject the DVD. Some Linux configurations automatically unmount 
and eject the DVD when you press the DVD drive button.

The file browser in the bin directory attempts to start common web browsers. Edit 
the file in any text editor to adjust it for your preferred web browser. The variable 
BROWSERS in this file contains a list of web browsers in order of preference. The default 
list contains the following web browsers:

• Mozilla

• Firefox

• Konqueror

If you have a Named Single User License and you are installing the 
software on the license server a dialog box opens up and you are asked to 
enter the user to bind the license to.Note
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• Opera

• Netscape

If you, for example, want to make Opera the preferred web browser, put it first in the 
list.

Cluster Installation

The installation instructions can be followed also for clusters, considering the 
following:

License manager   COMSOL requires a floating network license on clusters. Please 
check the license file for the CLUSTERNODE feature. The license manager needs to 
be accessible from all nodes in the cluster. Therefore it is often a good idea to have it 
run on the head node. See License Manager Installation.

Installation folder   The COMSOL installation folder should be shared between all 
compute nodes and the head node.

Features   During installation, make sure you select the Cluster Components feature.

Access to Cluster   If you work on a computer not on the cluster, install COMSOL on 
that computer. Typically, you use a scheduler to launch jobs on the cluster. Make sure 
the scheduler client software is installed on the that computer. You can preconfigure 
the installation to use the scheduler by changing the comsol.ini file according to 
section MPI Options.

Removing (Uninstalling) the COMSOL Installation

The COMSOL 4.3 installation adds files only in the comsol42 directory. To remove 
the COMSOL installation, simply delete the comsol42 directory including all 
subdirectories.

To make sure all users can easily start COMSOL, include the comsol43/
bin directory in all users’ paths or make a symbolic link from /usr/
local/bin/comsol to the comsol command (see the ln command).Tip
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Automated Installation

You can supply an answer file to the installer to run an unattended installation or to 
avoid the need of a display during the installation. The documentation on how to 
create an answer file is available in the template answer file, setupconfig.ini, which 
you find on the DVD. When you have created an answer file, start the installation by 
running

 <path to DVD>/setup -s <answer file path>

where <answer file path> is the path to your answer file.

Configuring Model Library Update

Using the preferences described under Updates in the section Editing Preferences 
Settings in the COMSOL Multiphysics User Guide you can configure proxy server 
settings as well as model and documentation directories for Model Library Update. See 
also Documentation and Model Library Root Directories for the related COMSOL 
options -docdir and -modelsdir.

Changing the Path to the MATLAB Installation

Change the path to the MATLAB installation in the user preferences you can access 
directly from the COMSOL Desktop. See the LiveLink products section in Editing 
Preferences Settings in the COMSOL Multiphysics User’s Guide.
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L i c e n s e  Manag e r  I n s t a l l a t i o n

In this section you will find the following information:

• System Requirements

• Obtaining a FlexNet License File

• License Manager Installation on Linux

• Changing the License

• Obtaining a Hostid

The license manager supports a heterogeneous network of Windows, Linux, and Mac 
OS X computers. Both the license manager and a COMSOL application can run on 
either Windows, Linux, or Mac platforms. The computer where the license manager is 
installed is called the license server and any computer that has the COMSOL 
applications installed is called clients. COMSOL can be installed anywhere, typically 
on a local PC or on a file server where users access the program over a network. A 
single computer can function as a license server and a client, holding both the license 
manager and COMSOL. The COMSOL license manager does not require a MATLAB 
license manager.

The license manager and COMSOL can be installed in any order. A full test of the 
installation cannot be done until both are installed.

COMSOL uses the FlexNet™ license manager version 11 from Flexera Software, Inc. 
for license management.

System Requirements

Before starting the installation process, check that your system meets all necessary 
requirements. They are crucial for the COMSOL application, whereas the license 
manager only needs the correct hardware and operating system—for the license 
manager, memory and graphics requirements are not necessary. The COMSOL license 
manager is completely independent of the MATLAB license manager.

FlexNet was formerly called FLEXlm.

Note
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Obtaining a FlexNet License File

To install a COMSOL license manager requires a FlexNet license file, license.dat. 
It looks something like this:

#------------------------------------------------------------------
# COMSOL 4.2a FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
SERVER my_server 0050569e1b87 1718
USE_SERVER
VENDOR LMCOMSOL port=1719
FEATURE SERIAL LMCOMSOL 4.2 permanent uncounted \
    VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
    SIGN=0C3A8BF6722E
INCREMENT COMSOL LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT HEATTRANSFER LMCOMSOL 4.2 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLIENTSERVER LMCOMSOL 4.2 permanent 4 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLUSTERNODE LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=U \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC

In the license.dat file, the text on the SERVER line should contain the license server 
name <my_server>, the hostid of the license server, and an optional port number.

Confirm that the license server name is the actual name of your license server; 
otherwise, change it by editing the file. The default port number (1718) can also be 
changed in the unlikely case that another program is already using that port number. 
If the default port number is being used, change it to another number between 1025 
and 64,000.

A COMSOL license.dat file is shipped with the COMSOL package. If 
the file has not been received, contact your local COMSOL representative 
or send a request to support@comsol.com.Note
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The VENDOR line defines the name of the vendor daemon binary, LMCOMSOL.

The SERIAL line contains license information.

The INCREMENT (can also be FEATURE) lines contain a product name, version, 
expiration date, and the number of available licenses. The example file above shows 
that the user has a permanent COMSOL 4.2a license allowing four concurrent users 
of COMSOL Multiphysics and two concurrent users of the Heat Transfer Module. 
The number after “SIGN=” at the end of each INCREMENT line contains a license key. 
Long lines can be broken by a continuation character (\).

In the license.dat file has not been received, provide COMSOL with the hostid of 
your license server (for Windows, see Obtaining a Hostid, for Linux, see Obtaining a 
Hostid, and for Mac, see Obtaining a Hostid for instructions) and preferably the 
license server name. Have these ready when contacting your local COMSOL 
representative.

If the COMSOL license manager is running on a computer with an active 
firewall and the COMSOL Multiphysics client is outside of that firewall, 
at least two port numbers must be opened up in the license server’s 
firewall to allow client computers to connect to the COMSOL license 
manager. 

To implement this requirement, make sure the VENDOR line in the 
license.dat file reads VENDOR LMCOMSOL port=1719
(the number can be any unused port number in the allowed range). Then 
configure the firewall to allow access to the chosen port numbers (in the 
example above, 1718 and 1719). If you are unsure about which port 
numbers are free or how to enable firewall port access, contact your 
system administrator.

Do not modify anything in the license.dat file except license server 
name and (if necessary) port numbers or the license may not work.

Important

Caution
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License Manager Installation on Linux

You do not need to install the license manager if you are installing a trial version. The 
full version, however, always requires a running license manager on Linux.

You need the following components on the license server:

• COMSOL License Manager files (FlexNet)

• License file (license.dat).

C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of three components:

• License manager daemon (lmgrd)

• Vendor daemon (LMCOMSOL)

• FlexNet utility programs (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user starts 
COMSOL on a client computer, communication is established through the network 
from the client to the license server and the lmgrd daemon. The lmgrd daemon in turn 
makes a request to the vendor daemon (LMCOMSOL) to release a license. The vendor 
daemon releases licenses according to information contained in license.dat. The 
utility programs are used for license-server management. For more information, select 
Help>Documentation from the main menu, and scroll to the bottom of the page to 
locate a PDF copy of the FlexNet Licensing End Users Guide (see Chapter 7).

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S

The license manager should be installed only on the host(s) listed in license.dat.

If you want to install COMSOL on the same host as the license manager, first perform 
a complete COMSOL installation because that procedure automatically installs the 
license manager files along with COMSOL (see Installing COMSOL). When finished, 
skip the remainder of this section and continue at Starting the License Manager.

If you want to install only the COMSOL license manager files, follow these 
instructions:

1 Insert the DVD into the DVD drive.

2 To start the installation, enter the following command:

/media/cdrom/setup

depending on where /media/cdrom is the mount point of the DVD drive.
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3 Continue according to the installation instructions starting with Installing 
COMSOL until the step where you see the Features screen.

4 In the list of products to install, select only the License Manager check box.

5 Resume the installation instructions with the Features screen to complete the license 
manager file installation.

Automated License Manager Installation
Alternatively, you can install the license manager using an automated installation 
process with minimal user interaction. See the section Automated Installation. Set 
licmanager = 1 in the answer file to install the license manager.

L I C E N S E  F I L E S  F O R  N A M E D  S I N G L E  U S E R  L I C E N S E

If you have a Named Single User License the installer automatically creates an options 
file that binds the license to the named user. This section describes the format of the 
options file and how the license.dat file points to the options file.

Below is an example of an options file, LMCOMSOL.opt, for a user “philip” who has 
access to COMSOL Multiphysics, the Structural Mechanics Module, and the CAD 
Import Module. Notice that to access COMSOL Multiphysics, the options file must 
include both the COMSOL and the COMSOLGUI features.

INCLUDE COMSOL USER philip
INCLUDE COMSOLGUI USER philip
INCLUDE CADIMPORT USER philip
INCLUDE CADREADER USER philip
INCLUDE STRUCTURALMECHANICS USER philip

Each INCLUDE row in the LMCOMSOL.opt file has a corresponding FEATURE row in the 
license.dat file (with the USER_BASED keyword). The second item on each FEATURE 
row is the name of the feature for which you have a license.

The following table contains the feature names for all products in the COMSOL 4.3 
product family:

TABLE 3-3:  COMSOL 4.3 PRODUCTS AND THEIR FEATURE NAMES

PRODUCT/FEATURE FEATURE NAMES

COMSOL Multiphysics COMSOL

COMSOL Multiphysics GUI COMSOLGUI

COMSOL Multiphysics floating network license CLIENTSERVER, 
CLUSTERNODE

AC/DC Module ACDC

Acoustics Module ACOUSTICS
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The license.dat file needs to point to the options file. The path to the options file is 
indicated by the “options” keyword. If your options file is placed here:

/usr/local/comsol43/license/LMCOMSOL.opt

then the VENDOR row in license.dat should read

VENDOR LMCOMSOL options=/usr/local/comsol43/license/LMCOMSOL.opt

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

You can start the license manager manually or it can run automatically at boot.

Starting the License Manager Manually
To start the license manager manually, make the license/$arch directory the current 
directory and enter

Batteries & Fuel Cells Module BATTERIESANDFUELCELLS

CAD Import Module CADIMPORT, CADREADER

CFD Module CFD

Chemical Reaction Engineering Module CHEM

Electrodeposition Module ELECTRODEPOSITION

Geomechanics Module GEOMECHANICS

Heat Transfer Module HEATTRANSFER

LiveLink for AutoCAD LLAUTOCAD

LiveLink for Creo Parametric LLCREOPARAMETRIC

LiveLink for Inventor LLINVENTOR

LiveLink for MATLAB LLMATLAB

LiveLink for Pro/ENGINEER LLPROENGINEER

LiveLink for SolidWorks LLSOLIDWORKS

LiveLink for SpaceClaim LLSPACECLAIM

MEMS Module MEMS

Optimization Module OPTIMIZATION

Particle Tracing Module PARTICLETRACING

Plasma Module PLASMA

RF Module RF

Structural Mechanics Module STRUCTURALMECHANICS

Subsurface Flow Module SUBSURFACEFLOW

TABLE 3-3:  COMSOL 4.3 PRODUCTS AND THEIR FEATURE NAMES

PRODUCT/FEATURE FEATURE NAMES
 3 :  I N S T A L L I N G  A N D  R U N N I N G  O N  L I N U X



./lmgrd -c ../license.dat -l /var/tmp/comsol43.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol43.log.

Starting the License Manager Automatically at Boot
Add Bourne shell commands to the appropriate boot script. You must be a superuser 
(root) to edit boot scripts.

The procedure for editing boot scripts on each platform appears in the following table 

For security reasons, it is recommended that the daemons is not started as 
root. Instead, use a dedicated username to start the license manager.

Caution

TABLE 3-4:  BOOT SCRIPT PROCEDURES

PLATFORM PROCEDURE

SuSE Linux The following instructions should work for SuSE Linux distributions, where 
$arch is either glnx86 (32-bit Linux), or glnxa64 (64-bit Linux).

In the comsol43/license/$arch directory, enter the commands

cp rc.lm /etc/init.d/comsol43lm
chmod 755 /etc/init.d/comsol43lm

Edit /etc/init.d/comsol43lm, replacing dir with the full path to the $arch 
platform directory, and replace username with an actual username.

Now create the following link

cd /etc/init.d/rc5.d
ln -s ../comsol43lm S91comsol43lm
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S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s) you can start using COMSOL.

Changing the License

If you have received a new license file—for example, when adding COMSOL products 
to an existing license—replace your current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that your 
license includes.

When you have changed the license file you must restart the license manager; 
otherwise, it will continue to use the old license file still in memory.

R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R

To restart the license manager, make the license/$arch directory under the 
COMSOL installation directory the current directory, then enter the following 
commands:

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol43.log

Debian 
Linux

The following instructions should work for Debian Linux distributions, where 
$arch is either glnx86 (32-bit Linux), or glnxa64 (64-bit Linux).

Copy the file comsol43/license/$arch/lm_comsol to /etc/init.d

Edit /etc/init.d/lm_comsol. Update the FP and MYUSER variables as 
indicated in the file. Use the utility update-rc.d to automatically update the 
system's init script links:

update-rc.d lm_comsol start 99 2 3 4 5 . stop 1 0 1 6 .

This means that the COMSOL license manager is started by runlevels 2, 3, 4, 
and 5, and stopped by runlevels 0, 1, and 6. Enter man update-rc.d for more 
information on init scripts. 

Linux The following instructions should work for most Linux distributions, where 
$arch is either glnx86 (32-bit Linux) or glnxa64 (64-bit Linux).

Copy the file comsol43/license/$arch/rc.lm and paste it at the end of 

/etc/rc.d/rc.local.

Replace ‘dir’ in the code fragment with the full path to the $arch platform 
directory, and replace ‘username’ with an actual username.

TABLE 3-4:  BOOT SCRIPT PROCEDURES

PLATFORM PROCEDURE
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Obtaining a Hostid

If COMSOL is already installed on your license server, you can determine the hostid 
by executing the lmhostid command

comsol43/license/$arch/lmhostid

where $arch is glnx86 (32-bit Linux) or glnxa64 (64-bit Linux).

If COMSOL is not installed, you must obtain a hostid using the following command 
on the license server: /sbin/ifconfig eth0. Then remove colons from, for example, 
HWaddr 00:40:05:16:E5:25 (do not use the hostid command). All machine 
architectures use an Ethernet address (also called a MAC address) as the hostid. An 
Ethernet address has six bytes, each with two hexadecimal digits. Be sure to specify all 
twelve hex digits when using an Ethernet address as a hostid. For example, if the 
Ethernet address is 8:0:20:0:5:ac specify 0800200005ac as the hostid.
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T r oub l e s h oo t i n g  L i c e n s e  E r r o r s

This section summarizes the most common post-installation error messages generated 
by COMSOL, and it gives some advice how to troubleshoot them. Also check the 
COMSOL Support Knowledge Base at www.comsol.com/install for up-to-date 
information about installation and license issues.

TABLE 3-5:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, send the complete error message to 
support@comsol.com.

License error: -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

/var/tmp/comsol43.log

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

NOTE: The license manager creates the log file. If there is no log 
file, make sure to first start the license manager. Please refer to the 
section License Manager Installation for instructions how to 
install and start the COMSOL license manager. 

License error: -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com. The log file is usually placed here:

/var/tmp/comsol43.log
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License error: -15. 
Cannot connect 
to license server 
system.

The COMSOL license manager has not been installed or started 
yet. If the first line of your license.dat file looks like this:

   SERVER mylicserver 000123456789 1716

a license manager is required. Please refer to the section License 
Manager Installation for instructions how to install and start the 
COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client 
computer points to the correct license server hostname. First, find 
the license.dat file in the COMSOL application folder:

/usr/local/comsol43/license/license.dat

Check that the first line has the correct license-server hostname. 
For example, if your license server hostname is mylicserver, the 
first row in the license.dat file should look like this:

   SERVER mylicserver 000123456789 1716

If the COMSOL client computer does not recognize 
mylicserver as a proper hostname, it might help to instead use 
the fully qualified domain name (mylicserver.mydomain.org) 
or the IP address. If neither of these work, there might be a 
problem with DNS or the HOSTS file on the client. Please ask 
your system administrator for advice on how to connect with 
TCP/IP to the license server.

Finally, the license manager might have encountered a problem 
during startup. Check the license manager log file for error 
messages. The log file is usually placed here:

/var/tmp/comsol43.log

NOTE: The log file is created by the license manager after it has 
been started.

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

TABLE 3-5:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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License error: -39. 
User/host not on 
INCLUDE list for 
feature.

This error can only occur for the Named Single User License 
(NSL) license type. The error means that your username does not 
match the one listed in the license-manager options file, 
LMCOMSOL.opt. To get access to COMSOL, ask your license/
system administrator for help. When the username in the options 
file is changed, the license manager must be shut down and 
restarted to give the new user immediate access to COMSOL. 

License error: -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current 
local time and date. If the problem remains check that there are no 
files on your hard drive that are dated in the future.

License error: -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER hostname in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

The license.dat file is located in the COMSOL application 
folder:

/usr/local/comsol43/license/license.dat

License error: -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

/var/tmp/comsol43.log

Note: The log file is created by the license manager after it has 
been started. 

Please send the log file to support@comsol.com if you want help 
in interpreting the information. 

TABLE 3-5:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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Runn i n g  COMSOL

In this section you will find the following information:

• Running COMSOL Multiphysics

• Running COMSOL on Multicore and Multiprocessor Computers

• Running a Classkit License

• Running COMSOL in Batch Mode

• Running COMSOL on Clusters

• Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics

Run the comsol command. If it is not available, ask your system manager to make it 
available to you. The comsol command is located in the bin folder in the COMSOL 
installation directory.

Running COMSOL on Multicore and Multiprocessor Computers

COMSOL uses all cores and all processors on your computer to run using 
shared-memory parallelism. 

Running a Classkit License

To start COMSOL using a classkit license, start COMSOL using the -ckl option, for 
example

comsol -ckl

To override this behavior, see Shared-Memory Parallel COMSOL in the 
COMSOL Multiphysics User’s Guide.

Note
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Running COMSOL in Batch Mode

COMSOL batch jobs can be submitted from the COMSOL Desktop and the 
command line by right-clicking a Study node in the Model Builder and selecting Batch.

Running COMSOL on Clusters

COMSOL cluster jobs can be launched from the COMSOL Desktop and the 
command line. To run COMSOL on a cluster, the feature must be enabled by clicking 
the Show button ( ) and selecting Advanced Study Options. Then in the Model Builder, 
right-click a Study node and select Cluster Computing to create cluster jobs.  

Running COMSOL Multiphysics with MATLAB

To launch MATLAB and connect it to a COMSOL server, run the command

comsol server matlab

For command-line options, see COMSOL Batch Commands.
See Also

Cluster computing requires an FNL (floating network) license.

For more information about how to run COMSOL in parallel on Linux 
clusters, see Running COMSOL in Parallel in the COMSOL Multiphysics 
User’s Guide.

For command-line options, see COMSOL Cluster Commands.

Note

See Also

Running COMSOL Multiphysics with MATLAB starts a COMSOL 
server and a MATLAB Desktop. No COMSOL graphical user interface is 
involved. For tutorial, see the LiveLink for MATLAB User’s Guide.Tip
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Th e  COMSOL Command s

Use the COMSOL command to start COMSOL products with detailed start-up 
options.

The general syntax of the COMSOL command is

comsol [<target>] [<options>] [<target arguments>]

where square brackets indicate optional arguments. The comsol command can be 
combined with optional targets to achieve various results. The table below lists the 
command and targets.:

The comsol command is located in the bin folder in the COMSOL installation 
directory.

I N I  F I L E S

There is a number of .ini files in the subdirectories glnx86 and glnxa64 in the bin 
directory. It is sometimes recommended that you edit these files. For example, you can 
add options to any of the above commands by modifying the corresponding ini file. 
To change the option opt to value val, add the line

TABLE 3-6:  COMSOL COMMANDS TARGETS

COMMAND AND TARGET DESCRIPTION AVAILABILITY

comsol Run standalone 
COMSOL Multiphysics

comsol server Start COMSOL 
Multiphysics server

comsol client Run COMSOL 
Multiphysics client

comsol batch Run a COMSOL 
MPH-file or class file

comsol compile Compile a Model 
Java-file

comsol server matlab Start MATLAB and 
connect to a COMSOL 
server

Requires LiveLink for 
MATLAB license

comsol convertpre35a Convert 3.0–3.5 models

comsol mpd Run the COMSOL 
multiprocessing daemon

Requires 
CLUSTERNODE license
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-Dopt=val

to the file comsol.ini. Change the file comsolbatch.ini for comsol batch, and 
similarly for the other COMSOL targets.

O P T I O N S

You can enter various options after the COMSOL command and target. Table 3-7 lists 
the options (See [<options>] in the command syntax) available for all comsol 
commands. Always issue these options between the command and the target (if any).

TABLE 3-7:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE

-h Print general help

<target> -h Print target-specific help

-32 Run 32-bit COMSOL

-64 Run 64-bit COMSOL

-3drend ogl | sw 3D renderer: OpenGL 
or software rendering

-docroot <path> Specify custom path to 
the COMSOL 
documentation root 
directory.

See Documentation and 
Model Library Root 
Directories

-modelsroot <path> Specify custom path to 
the COMSOL Model 
Library root directory.

See Documentation and 
Model Library Root 
Directories

-np <no. of processors> Number of processors See Shared-Memory 
Options

-numasets <no. of sets> Number of NUMA sets See Shared-Memory 
Options

-mpmode throughput | 
turnaround | owner

Multiprocessor mode See Shared-Memory 
Options

-blas {auto} | mkl | acml | 
path

BLAS library to use See BLAS Options

-blaspath <path> BLAS library path See BLAS Options

-ipv6 Activate IPv6 support

-nn <no. of processors> Number of nodes See COMSOL Cluster 
Commands

-nnhost <no. of 
processors>

Number of nodes on 
each host

See COMSOL Cluster 
Commands
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-f <path> Path to hostfile See COMSOL Cluster 
Commands

-mpi {auto} | intel | mpich2 
| wccs2003 | whpc2008 | 
user | path

MPI library to use See COMSOL Cluster 
Commands

-mpipath <path> MPI library path See COMSOL Cluster 
Commands

-mpiroot <path> MPI library root path See COMSOL Cluster 
Commands

-mpirsh {rsh} | ssh Use rsh or ssh when 
booting MPD

See COMSOL Cluster 
Commands

-mpibootstrap {ssh} | rsh 
| fork | slurm | ll | lsf | 
sge | jmi

Set bootstrap server for 
Hydra

See COMSOL Cluster 
Commands

-mpibootstrapexec 
<path>

Executable used by 
bootstrap server

See COMSOL Cluster 
Commands

-mpienablex Enable Xlib forwarding See COMSOL Cluster 
Commands

-mpd Use MPD instead of 
Hydra launcher

See COMSOL Cluster 
Commands

-scalapack {auto} | 
mpich2 | wccs2003 | 
whpc2008 | user | path

Scalapack library to use See COMSOL Cluster 
Commands

-scalapackpath <path> Scalapack library path See COMSOL Cluster 
Commands

-clustersimple Simple startup of cluster See COMSOL Cluster 
Commands

-prefsdir <path> Preference directory

-tmpdir <path> Temporary file directory

-version Print COMSOL version

-version <target> Print target version

-ckl Use class-kit license

-forcegcc Force load of GCC 
libraries

-forcecomsolgcc Force load of GCC 
libraries shipped with 
COMSOL

TABLE 3-7:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE
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For the -tmpdir option, COMSOL software uses the specified directory to store 
temporary files. The -prefsdir option specifies the directory where COMSOL 
should store the preference file.

Documentation and Model Library Root Directories
In a default COMSOL installation, the documentation files are located in the directory 
doc under the installation root directory. You can use the -docroot option if you want 
to move the documentation directory to a different location. Similarly, use the 
-modelsroot option if you want to move the Model Library root directory models 
from its default location under the COMSOL installation root. Relocating the 
documentation and Model Library root directories can be useful for administering 
Model Library Update; see Configuring Model Library Update.

Shared-Memory Options
Use the option -np to control the number of core and processors used. The default is 
to use all available cores and processors.

Use the option -numasets to control the number of Non-Uniform Memory Access 
node sets COMSOL should take into account. This is usually the number of processor 
sockets that the hardware is using.

Depending on how loaded your machine is, you can control how COMSOL uses the 
available processors. The following options are available:

You may need to experiment to find the options that work best for your configuration.

-autosave <{on}|off> Control saving of 
recovery files

-recoverydir <path> Path to recovery 
directories

TABLE 3-8:  COMSOL MULTIPROCESSOR MODE OPTIONS

MPMODE OPTION DESCRIPTION

throughput Is expected to give the best performance when several different 
processes are running actively at the same time as COMSOL.

turnaround Typically provides the best performance when no other processes than 
COMSOL are active.

owner Provides the highest performance in most cases.

TABLE 3-7:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE
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BLAS Options
BLAS is a set of functions for basic linear algebra operations. A large portion of the 
computational engine in COMSOL relies on BLAS. COMSOL provides for the 
following BLAS related options:

Both MKL and ACML are distributed along with COMSOL.

If you want to use a different BLAS library than the default, make sure that COMSOL 
can find the library. The simplest way for COMSOL to find a library is to put it in /
lib/ARCH where ARCH is the architecture (glnx86 or glnxa64) or somewhere in the 
standard search path. You must also provide the path to any sublibraries needed by the 
library. You can also set the search path to point to the directory where the library is 
installed. To do so, use the environment variable LD_LIBRARY_PATH.

GCC Options
By default COMSOL uses the GCC libraries installed on the system. If COMSOL is 
unable to start, COMSOL will attempt to use the GCC libraries shipped with 
COMSOL. To force COMSOL to use the shipped GCC libraries, use the 
-forcecomsolgcc option. The option -forcegcc is mainly intended for use together 
with the LiveLink interface for MATLAB; use it if you are unable to make function call 
backs to MATLAB.

C O M S O L  C O M M A N D S

In additions to the options in Table 3-7, the standalone COMSOL command supports 
the following option.

TABLE 3-9:  COMSOL BLAS OPTIONS

BLAS OPTION DESCRIPTION

auto Determine BLAS library automatically: MKL for Intel processors, and 
ACML for AMD processors with SSE2 support, otherwise MKL. (This is 
the default option.)

mkl Use the Intel MKL library

acml Use the AMD ACML library

path Use a BLAS library specified using the option -blaspath or the 
environment variable COMSOL_BLAS_PATH. The library must support 
the standard FORTRAN BLAS interface.

TABLE 3-10:  COMSOL COMMAND-LINE ARGUMENTS

COMSOL OPTIONS DESCRIPTION

-open <file> Open file
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C O M S O L  S E R V E R  C O M M A N D S

Use a COMSOL server command to start a COMSOL process ready to process 
computational requests. A COMSOL server listens for TCP/IP connections from 
COMSOL clients. A COMSOL Desktop can become a COMSOL client by 
connecting to a COMSOL server. The LiveLink interface for MATLAB also needs to 
connect to a COMSOL server.

The syntax for the COMSOL server command is

comsol [<options>] server [<target arguments>]

The following target arguments are available for a COMSOL server command.

Accessing the COMSOL Server Computer
To access the computer running the COMSOL server simply log in on the server 
computer by using ssh or a similar command, then enter the comsol server 
command.

Login Information
When you start a COMSOL Multiphysics server for the first time, you are asked for a 
user name and password. Select a user name and a password, which COMSOL 
Multiphysics then uses in communications between the COMSOL Multiphysics client 
and the server. You must also specify a matching user name and password in the 
Connect to Server dialog box. The software writes this login information in the 
subdirectory .comsol/v43/login.properties in your home directory.

TABLE 3-11:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL SERVER OPTIONS DESCRIPTION

-user <user> Specify login name for a user

-port <port> Specify a TCP/IP port to listen for connect 
attempts.

-passwd <reset/nostore> Specify that you want to provide a new 
password.To avoid storing the new password on 
file use <nostore>

-login <{info}/force/never> Ask for login information. info means that only 
missing information is asked for.

-multi on | {off} Accept repeated client connections

-silent Do not listen to standard input

-graphics Start the server with graphics libraries. This will 
display plots on the server when you are 
connected with a client (that is, not with the 
COMSOL GUI).
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Client/Server Security Issues
COMSOL Multiphysics can operate in a client/server mode where COMSOL 
Multiphysics runs as a separate client and a server. COMSOL Multiphysics uses a 
TCP/IP connection to send data between the server and the client.

Once you start a COMSOL Multiphysics server, a person with access to your login 
information could potentially connect to your COMSOL Multiphysics server. When a 
COMSOL Multiphysics client connects or disconnects from a remote computer, the 
COMSOL Multiphysics server displays a message. The connection from the client to 
the server is made with the TCP protocol.

The server and client are mutually authenticated using a challenge handshake 
authentication protocol, which means that login information cannot be easily obtained 
by someone eavesdropping on the network communication. The TCP connection 
between the client and the server is otherwise not encrypted. If you require encryption 
of the TCP connection, you can use third-party software based on protocols such as 
SSH or IPSEC.

C O M S O L  C L I E N T  C O M M A N D S

Use a COMSOL client command to start a COMSOL Desktop with a the Connect to 
Server dialog box open. 

The syntax for the COMSOL client command is

comsol [<options>] client [<target arguments>]

The following target arguments are available for a COMSOL client command.

Always make sure that untrusted users cannot access the COMSOL login 
information. Protect the file .comsol/v43/login.properties in your 
home directory. This is important when using COMSOL Multiphysics’ 
client/server feature. Alternatively, start the COMSOL server with the 
-passwd nostore option, and clear Remember Password when 
connecting to the server. This ensures that your login information is not 
stored on file.

Important

TABLE 3-12:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL CLIENT OPTIONS DESCRIPTION

-port <port> Specify a TCP/IP port to connect to

-server <server name> Specify server to connect to

-open <file> Open file
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C O M S O L  B A T C H  C O M M A N D S

Use the COMSOL batch command to run COMSOL jobs without a GUI. You can 
run both Model MPH files and Model Java-files with the COMSOL batch command. 
Model Java-files need to be compiled before running.

The syntax for the COMSOL batch command is

comsol [<options>] batch [<target arguments>]

Its detailed target arguments are:

Example
To use the COMSOL Batch mode to solve a model, run the following command:

comsol batch -inputfile in.mph -outputfile out.mph -job b3 -pname v -plist 10

This command starts COMSOL Batch, solves the model in the Model MPH-file with 
the given file name using the active solver settings in the model, and stores the solution 
in the out.mph.

TABLE 3-13:  COMSOL BATCH-SPECIFIC ARGUMENTS

COMSOL BATCH OPTIONS DESCRIPTION

-inputfile <file name> Run a Model MPH-file or class file

-outputfile <file name> Save a Model MPH-file using the given file 
name. If output is not given, the input file 
will be overwritten with the output

-job <job tag> The batch job to run

-study <study tag> The study to compute

-pname <parameter name> Comma separated list of parameter names

-plist <parameter value> Comma separated list of parameter values

-batchlog <file name> File to store log in

-client Run as client

-host Connect to host

-port Connect to port

-graphics Start COMSOL batch with graphics 
libraries. This will display plots during 
postprocessing. 

-nosave Do not save the resulting model
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T H E  C O M S O L  C O M P I L E  C O M M A N D

The COMSOL compile command compiles a Model Java-file for use by the COMSOL 
batch command or for loading class files into the GUI. The syntax for the COMSOL 
compile command is

comsol [<options>] compile [<target arguments>] <file>.java

The Java file is mandatory. The following optional target arguments are available‘

C O M S O L  C L U S T E R  C O M M A N D S

Use the COMSOL command with the option -nn <no. of nodes> to run 
COMSOL on clusters. 

The syntax for the COMSOL cluster command is

comsol -nn <no. of nodes> [<options>] [<target>] [<target arguments>]

The following cluster commands are available:

The preferred way of starting COMSOL cluster jobs is from the Study node in the 
COMSOL Desktop. If you need to start COMSOL cluster jobs from the command 
line, the preferred way is to use the comsol -nn <nn> batch command since the 
comsol -nn <nn> server and comsol -nn <nn> commands require TCP/IP access 
from your client computer to the cluster node where COMSOL runs.

Running on Linux
As of version 4.3, COMSOL uses Hydra by default to initialize the MPI environment. 
Hydra is more scalable than MPD and it does not require any additional commands to 
launch.

To launch COMSOL with Hydra use the command line

TABLE 3-14:  COMSOL COMPILE OPTIONS

COMSOL COMPILE OPTIONS DESCRIPTION

-jdkroot <path> Path to the JDK root

-classpathadd <classpath> Additional classpath

-verbose Verbose output

TABLE 3-15:  COMSOL CLUSTER TARGETS

COMSOL CLUSTER COMMANDS DESCRIPTION

comsol -nn <nn> batch Run COMSOL on a cluster in batch mode

comsol -nn <nn> server Run COMSOL server on a cluster

comsol -nn <nn> Run COMSOL Desktop on a cluster 
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comsol -nn <number of computer nodes> -f <filename>

The file <filename> should contain the host names of the computer nodes that you 
intend to use. You can find out the hostname of each node from the Linux command 
hostname. Each node should be listed on a separate line in the file. You can also list 
the IP address of each node. The file may contain more computer nodes than you 
actually intend to use. You can set the remote node access mechanism that is used for 
connecting using the switch -mpibootstrap. The valid options are ssh, rsh, fork, 
slurm, ll, lsf, sge and jmi. This is important if the cluster only supports a different 
remote node access mechanism than ssh because ssh is the default protocol used. Use 
the switch -mpibootstrapexec to set the path to the remote node access mechanism 
such as /usr/bin/ssh. Use -mpienablex to enable Xlib forwarding. Xlib forwarding 
is off by default.

Previously there was a shorthand for performing the COMSOL MPI environment 
initialization and starting COMSOL. The -clustersimple option is still supported 
but is equivalent to the Hydra command by default, for example

comsol -nn 4 -clustersimple

You should usually run COMSOL in batch mode. Use the command

comsol -clustersimple batch -inputfile input.mph -outputfile 
output.mph

It allows the Intel MPI library to automatically detect the number of nodes that were 
scheduled to the program. Restricting the number of processes with the -nn switch 
allows COMSOL to combine MPI with multithreading. This is the most efficient way 
to run COMSOL.

Using the MPD launcher
Before version 4.3 the MPI environment was launched by MPD. You can still use 
MPD if you use the switch -mpd but it is recommended that you use Hydra.

In order to start MPI, have a file named .mpd.conf in your home directory to which 
you alone have access. This file should contain the single line

secretword = <your secret word here>

On Intel MPI shipped with COMSOL, the .mpd.conf file is optional.

Below, the details of the individual cluster commands are described.

Before you start COMSOL, you must initialize the MPI environment. A so called 
multiprocessing daemon (MPD) must run on each computer node that you intend to 
use. To start MPD on several computer nodes, enter
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comsol -nn <number of computer nodes> mpd boot -f <filename>

The file <filename> should contain the host names of the computer nodes that you 
intend to use. You can find out the hostname of each node from the Linux command 
hostname. Each node should be listed on a separate line in the file. You can also list 
the IP address of each node. The file may contain more computer nodes than you 
actually intend to use. As an alternative to using the -f <filename> option, you can 
put the list of computer nodes in a file named mpd.hosts in your home directory. You 
can set the protocol that is used for connecting using the switch -mpirsh. The valid 
options are rsh and ssh. This is important if the cluster only supports ssh because rsh 
is the default protocol used. Make sure that all nodes were booted by listing them with 
the command

comsol mpd trace

Start distributed COMSOL with the -nn option. For example, enter

comsol -nn <number of computational nodes> -mpd server

to start a COMSOL server running on a specific number of computational nodes. The 
number of computational nodes can exceed the number of computer nodes. Use the 
-nnhost option if you want to force several computational nodes on a computer node. 
Avoid starting more computational nodes than the total number of processors that you 
have available. When you have finished using distributed COMSOL, you should take 
down all the MPDs. Enter the command

comsol mpd allexit

to stop all MPDs. To obtain more information about the comsol mpd commands, add 
the -h option to the commands, for example, comsol mpd boot -h.

Start MPD on a single computer with the command

comsol mpd mpd &

This is useful when running all computational nodes on a single multiprocessor 
computer or when you have difficulties attaching computational nodes because of 
firewalls. In the second case you can start an MPD on each node and attach them by 
specifying the main port and host. Use 

comsol mpd trace -l

and

comsol mpd mpd --port <the port number reported> --host <the 
    hostname reported>
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You can also start COMSOL with the -clustersimple option. This option 
automatically starts and terminates the MPD daemon. It uses the mpd.hosts file in 
your home directory to determine what computational nodes to use.

Starting Distributed COMSOL—Linux Examples
Make sure that COMSOL is able to start on all nodes where you intend to run 
COMSOL. 

A simplified version is used when the -clustersimple switch is set or the Hydra 
launcher is used. An example follows. Start four computational nodes on hosts listed 
in the file hosts using distributed COMSOL and simplified start:

comsol -nn 4 -clustersimple -f hosts alternatively
comsol -nn 4 -clustersimple -f hosts server alternatively
comsol -nn 4 -clustersimple -f hosts batch -inputfile in.mph -outputfile 
out.mph

where -clustersimple is optional for Hydra.

If you use MPD. Start an MPD on a single computer. Then start distributed 
COMSOL on two computational nodes (on the same host) each using three 
processors, and finally stop the MPD:

comsol mpd mpd &
comsol -nn 2 -np 3 -mpd alternatively
comsol -nn 2 -np 3 -mpd server alternatively
comsol -nn 2 -np 3 -mpd batch -inputfile in.mph -outputfile out.mph
comsol mpd allexit

The example above could be used if you have a very small model with a very large 
amount of parametric steps, where using mpd on a single computer might be beneficial.

Start three MPDs on computer nodes with hostnames defined in the file myhosts. 
Each line in the file should specify the host address or IP-address of a node. Make sure 
the MPDs were correctly booted. Then start a distributed COMSOL server on three 
computational nodes, and finally stop the MPDs. First make sure that you can connect 
to all the computers with ssh without having to use your password (see the man pages 
for ssh). Also make sure that all computers have access to the same COMSOL 
installation and that they are using the same Linux version. There are two options for 

Each node requires access to the license manager. If the node is unable to 
check out a license, it aborts the startup process.

Important
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starting a session. One more detailed and one shorthand version. An example of the 
detailed version:

comsol -nn 4 mpd boot -f myhosts
comsol mpd trace
comsol -nn 4 -mpd alternatively
comsol -nn 4 -mpd server alternatively
comsol -nn 4 -mpd batch -inputfile in.mph -outputfile out.mph
comsol mpd allexit

MPI Options
There are several implementations of MPI. COMSOL is shipped with the Intel MPI 
library but should also support most MPI implementations based on MPICH2. It is 
recommended that you use the default Intel MPI library. For running COMSOL on a 
computer that has MPICH2 installed, COMSOL also has a compatibility mode that 
you can activate by adding the option -mpi mpich2. When using this option both the 
variables PATH and LD_LIBRARY_PATH must include your MPI implementation. It is 
also possible to use other MPI libraries based on MPICH2 using the option -mpipath 
<path to shared library> and -mpiroot <path to root of mpi library 
installation>. Table 3-7 lists the MPI related options, -mpi, -mpipath, 
-scalapack, and -scalapackpath. Additionally the comsol MPI arguments are 
configurable inside the comsol start script. To configure comsol to work with a job 
scheduler through the Cluster Computing study you can set the options

-Dcs.precmd=<Command line>

-Dcs.postcmd=<Command line>

in the comsol.ini file. This will add commands prior to the comsol command and 
after the comsol command. You can add {nn} or {perhost} to any of these pre- or 
postcommands. This configures the Cluster Computing study to use the number of 
nodes and number of nodes on each host from the corresponding settings for the 
Cluster Computing study. For more information see the documentation for the 
Cluster Computing study in the COMSOL Multiphysics Reference Guide.

Troubleshooting Distributed COMSOL and MPI
The Hydra launcher is the main MPI environment from version 4.3. The syntax for 
Hydra commands is
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comsol [<options>] hydra [<Hydra command>] [<target arguments>]

Use the -h switch for more information about each command.

The MPD daemon can be used in several ways to troubleshoot problems with the 
comsol MPI environment. The syntax for MPD commands is

comsol [<options>] mpd [<MPD command>] [<target arguments>]

Use -h switch for more information about each command.

Comsol is shipped with the Intel MPI library, but should be compatible with most 
MPICH2 compatible MPI libraries. To download the latest version of Intel MPI 
library runtime visit http://software.intel.com/en-us/intel-mpi-library. To run 
comsol with another version of Intel MPI or other MPI library set -mpiroot to the 
root path of the MPI library and -mpipath to the dynamically loaded library that 
should be used. The default of the Intel MPI library is to use ssh as communication 
protocol. If you require another communication protocol use the option 
-mpibootstrap <protocol>. If you are using a scheduler the Intel MPI library is 

TABLE 3-16:  COMSOL HYDRA COMMANDS

COMSOL MPD COMMANDS DESCRIPTION

cleanup Run mpicleanup command

tune Run mpitune command

TABLE 3-17:  COMSOL MPD COMMANDS

COMSOL MPD COMMANDS DESCRIPTION

boot Run mpdboot command

mpd Run mpd command

exit Run mpdexit command

allexit Run mpdallexit command

cleanup Run mpdcleanup command

trace Run mpdtrace command

check Run mpdcheck command

ringtest Run mpdringtest command

listjobs Run mpdlistjobs command

sigjob Run mpdsigjob command

killjobs Run mpdkilljobs command

tune Run mpdtune command

help Run mpdhelp command
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often able to detect the environments it is running from using the -clustersimple 
switch and you do not need to set up a hosts file. The Intel MPI library automatically 
tries to detect the best option for communication and uses InfiniBand if it detects it. 

If comsol aborts during start make sure that all nodes are able to access the license 
manager and that comsol can be started on each node when not running distributed.

For more verbose information about the startup process when using Hydra, use 
-mpiarg -verbose or set the environment variable I_MPI_DEBUG to a value greater 
than 0.

When using MPD, use comsol mpd check command to display important 
information. For more verbose information about the startup process from the MPD 
daemon use the -v and/or -d switches or set the environment variable I_MPI_DEBUG 
to a value greater than 0. If the MPD is booted and comsol is not starting make sure 
that the MPI environment is working for instance by running the comsol mpd tune 
command. 

C O M S O L  M AT L A B  C O M M A N D

Use the COMSOL MATLAB command to access the COMSOL Java API through 
MATLAB. Type:

comsol server matlab [<options>]

which launches a COMSOL server in a console window, starts MATLAB, and 
connects MATLAB to the COMSOL server. 

The following options are available for the comsol server matlab command:

TABLE 3-18:  COMSOL MATLAB OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-mlroot <path> MATLAB installation directory

-host <hostname> Connect to host

-port <hostname> Connect to port

-desktop Start with Desktop

-nodesktop Start without Desktop

-mlnosplash Start without MATLAB splash screen

-graphics Start the server with graphics libraries. This enables 
plotting on the server. Available only when running 
comsol server matlab [<options>].
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C O M S O L  C O N V E R T P R E 3 5 A  C O M M A N D

Use the comsol convertpre35a command to convert a directory with models made 
in COMSOL 3.0–3.5 to COMSOL 3.5a. To use the command, enter

comsol [options] <input directory> <output directory> [log file]

where <input directory> is the input directory, <output directory> is the output 
directory, and [log file] is an optional log file. If you do not provide the third 
argument, the log is printed to the standard output.

TABLE 3-19:  COMSOL CONVERTPRE35A OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-c35aroot <path> Installation path of COMSOL 3.5a
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I n s t a l l i n g  a n d  R u n n i n g  o n  M a c  O S  X
This chapter provides detailed instructions for installing the COMSOL software 
on Mac OS X. You also find license manager information and options for running 
COMSOL. For most installations, the COMSOL Quick Installation Guide  that 
comes bundled with the DVD provides the basic instructions for installation on 
Mac OS X. See also the COMSOL Support Knowledge Base on www.comsol.com/
install for specific troubleshooting tips.

In this chapter:

• System Requirements

• Installing COMSOL

• License Manager Installation

• Troubleshooting License Errors

• Running COMSOL

• The COMSOL Commands
 99

www.comsol.com/install
www.comsol.com/install


100 |  C H A P T E
S y s t em Requ i r emen t s  

In this section:

• COMSOL Multiphysics System Requirements for Mac OS X

• LiveLink for MATLAB Requirements

• Products for CAD Interoperability

• Parallel System Requirements

• Internet Protocol Support 

COMSOL Multiphysics System Requirements for Mac OS X

S Y S T E M  R E Q U I R E M E N T S — I N T E L  3 2 - B I T  P R O C E S S O R

• Mac OS X 10.5, 10.6, or 10.7

• Java 1.5 or 1.6

S Y S T E M  R E Q U I R E M E N T S — I N T E L  6 4 - B I T  P R O C E S S O R

• Mac OS X 10.5, 10.6, or 10.7

• Java 1.5 or 1.6

J A V A  A V A I L A B I L I T Y

In Mac OS X 10.5 and 10.6 Java is included by default. In Mac OS X 10.7 Java needs 
to be downloaded and installed.

• Open Finder>Applications>Utilities. Open Java Preferences. If Java is not installed on 
the system, you will be asked to do so.

For the most current system requirements, see 
www.comsol.com/products/requirements/

Note

.
See Also
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G R A P H I C S  S Y S T E M  R E Q U I R E M E N T S

Prefer hardware rendering for performance reasons: drivers supporting OpenGL 
version 1.4 are required. Alternatively, use software rendering.

LiveLink for MATLAB Requirements

LiveLink for MATLAB is compatible with MATLAB 2012a and 2011b for Mac OS X.

Products for CAD Interoperability

The following products support import of 3D CAD files on OS X: 

See Table 4-2 for detailed version information on the supported file formats.

Parallel System Requirements

COMSOL 4.3 supports shared-memory parallelism on 32-bit and 64-bit Mac OS X. 
Distributed-memory parallelism is not supported.

The CAD Import Module requires 64-bit Mac OS X.
Important

TABLE 4-1:  PRODUCTS FOR CAD INTEROPERABILITY ON OS X

PRODUCT SUPPORTED FILE FORMATS REQUIRED PRODUCT

CAD Import Module ACIS (SAT), IGES, Parasolid, 
Pro/E, and STEP

COMSOL Multiphysics

TABLE 4-2:  3D CAD FILE FORMATS SUPPORTED BY COMSOL PRODUCTS ON MAC OS X.

FILE FORMAT (FILE EXTENSION) SUPPORTED VERSION

Parasolid (.x_b, .x_t) up to V22

ACIS or SAT (.sab, .sat) up to R21

STEP (.step, .stp) AP203, AP214

IGES (.iges, .igs) up to 5.3

Pro/ENGINEER (.prt, .asm) 16 to Wildfire 5

Creo Parametric (.prt, .asm) 1.0
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Internet Protocol Support

IPv4 is supported on all Mac OS X platforms.
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I n s t a l l i n g  COMSOL

In this section:

• Before You Begin

• Installing COMSOL 4.3

• Removing (Uninstalling) the COMSOL Installation

• Automated Installation

• Changing the Path to the MATLAB Installation

Before You Begin

• Check that the system meets all applicable requirements (see COMSOL 
Multiphysics System Requirements for Mac OS X).

• Have the passcode or license file ready. A passcode has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

New users can find the passcode or the license file in an email or letter from your sales 
representative. If a passcode or a license file has not been received, contact your local 
COMSOL representative.

Some COMSOL license types require that a license manager is installed before running 
a COMSOL software product. If COMSOL software is installed with a passcode, no 
license manager is needed. If it is installed with a license file, the license manager needs 
to be installed if the license file contains a line starting with the word SERVER. See 
License Manager Installation for instructions. The COMSOL software products and 
the license manager can be installed in any order.

If your Macintosh contains an old COMSOL (FEMLAB) installation, the 
COMSOL 4.3 installer does not remove it; it only removes the MATLAB path to the 
old COMSOL. The old version can be kept as well as uninstalled before or after 
installing COMSOL 4.3.
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Installing COMSOL 4.3 

1 Insert the COMSOL 4.3 DVD into the DVD drive. Launch the COMSOL Installer 
application from the Finder. The COMSOL 4.3 Installer window appears.

2 To proceed, see the instructions for Windows in the section Installing COMSOL. 
The procedure is the same for Mac OS X.

Removing (Uninstalling) the COMSOL Installation

The COMSOL 4.3 installation adds files only in the COMSOL43 folder. To remove the 
COMSOL installation, delete the COMSOL43 folder including all subfolders.

Automated Installation

COMSOL can be installed using an automated installation process with minimal user 
interaction. The documentation on how to create an answer file is available in the 
template, setupconfig.ini, which is on the DVD. When an answer file is created, 
start the installation by running

 <path to DVD>/setup -s <answer file path>

where <answer file path> is the path to the answer file.

Configuring Model Library Update

Using the preferences described under Updates in the section Editing Preferences 
Settings in the COMSOL Multiphysics User Guide you can configure proxy server 
settings as well as model and documentation directories for Model Library Update. See 

COMSOL does not work if the path to the COMSOL folder, or the name 
of the COMSOL folder itself, contain spaces.

Important

You cannot browse to the MATLAB installation directory directly. You 
need to enter it manually. MATLAB is installed in the /Applications 
directory, for example, as /Applications/MATLAB_R2012a.app. Note
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also Documentation and Model Library Root Directories for the related COMSOL 
options -docdir and -modelsdir.

Changing the Path to the MATLAB Installation

Change the path to the MATLAB installation in the user preferences you can access 
directly from the COMSOL Desktop. See the section LiveLink products in Editing 
Preferences Settings in the COMSOL Multiphysics User’s Guide.
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L i c e n s e  Manag e r  I n s t a l l a t i o n

In this section:

• System Requirements

• Obtaining a FlexNet License File

• License Manager Installation on Mac OS X

• Changing the License

• Obtaining a Hostid

The license manager supports a heterogeneous network of Windows, Linux, and Mac 
OS X computers. Both the license manager and a COMSOL application can run on 
either Windows, Linux, or Mac platforms. The computer where the license manager is 
installed is called the license server and any computer that has the COMSOL 
applications installed is called clients. COMSOL can be installed anywhere, typically 
on a local PC or on a file server where users access the program over a network. A 
single computer can function as a license server and a client, holding both the license 
manager and COMSOL. The COMSOL license manager does not require a MATLAB 
license manager.

The license manager and COMSOL can be installed in any order. A full test of the 
installation cannot be done until both are installed.

COMSOL uses the FlexNet™ license manager version 11 from Flexera Software, Inc. 
for license management.

System Requirements

Before starting the installation process, check that your system meets all necessary 
requirements. They are crucial for the COMSOL application, whereas the license 
manager only needs the correct hardware and operating system—for the license 
manager, memory and graphics requirements are not necessary. The COMSOL license 
manager is completely independent of the MATLAB license manager.

FlexNet was formerly called FLEXlm.

Note
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Obtaining a FlexNet License File

To install a COMSOL license manager requires a FlexNet license file, license.dat. 
It looks something like this:

#------------------------------------------------------------------
# COMSOL 4.2a FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
SERVER my_server 0050569e1b87 1718
USE_SERVER
VENDOR LMCOMSOL port=1719
FEATURE SERIAL LMCOMSOL 4.2 permanent uncounted \
    VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
    SIGN=0C3A8BF6722E
INCREMENT COMSOL LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT HEATTRANSFER LMCOMSOL 4.2 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLIENTSERVER LMCOMSOL 4.2 permanent 4 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2011 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLUSTERNODE LMCOMSOL 4.2 permanent 4 SUPERSEDE DUP_GROUP=U \
    ISSUED=6-JUN-2011 BORROW=720 SN=1234567 SIGN=123456789ABC

In the license.dat file, the text on the SERVER line should contain the license server 
name <my_server>, the hostid of the license server, and an optional port number.

Confirm that the license server name is the actual name of your license server; 
otherwise, change it by editing the file. The default port number (1718) can also be 
changed in the unlikely case that another program is already using that port number. 
If the default port number is being used, change it to another number between 1025 
and 64,000.

A COMSOL license.dat file is shipped with the COMSOL package. If 
the file has not been received, contact your local COMSOL representative 
or send a request to support@comsol.com.Note
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The VENDOR line defines the name of the vendor daemon binary, LMCOMSOL.

The SERIAL line contains license information.

The INCREMENT (can also be FEATURE) lines contain a product name, version, 
expiration date, and the number of available licenses. The example file above shows 
that the user has a permanent COMSOL 4.2a license allowing four concurrent users 
of COMSOL Multiphysics and two concurrent users of the Heat Transfer Module. 
The number after “SIGN=” at the end of each INCREMENT line contains a license key. 
Long lines can be broken by a continuation character (\).

In the license.dat file has not been received, provide COMSOL with the hostid of 
your license server (for Windows, see Obtaining a Hostid, for Linux, see Obtaining a 
Hostid, and for Mac, see Obtaining a Hostid for instructions) and preferably the 
license server name. Have these ready when contacting your local COMSOL 
representative.

If the COMSOL license manager is running on a computer with an active 
firewall and the COMSOL Multiphysics client is outside of that firewall, 
at least two port numbers must be opened up in the license server’s 
firewall to allow client computers to connect to the COMSOL license 
manager. 

To implement this requirement, make sure the VENDOR line in the 
license.dat file reads VENDOR LMCOMSOL port=1719
(the number can be any unused port number in the allowed range). Then 
configure the firewall to allow access to the chosen port numbers (in the 
example above, 1718 and 1719). If you are unsure about which port 
numbers are free or how to enable firewall port access, contact your 
system administrator.

Do not modify anything in the license.dat file except license server 
name and (if necessary) port numbers or the license may not work.

Important

Caution
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License Manager Installation on Mac OS X

The license manager only needs to be installed if a license file has been obtained that 
starts with a line containing the word SERVER. The following components are needed 
on the license server:

• COMSOL License Manager files (FlexNet)

• License file (license.dat)

C O M S O L  L I C E N S E  M A N A G E R  F I L E S  ( F L E X N E T )

The license manager consists of three components:

• License manager daemon (lmgrd)

• Vendor daemon (LMCOMSOL)

• FlexNet utility programs (lmutil and others)

The two daemons (lmgrd and LMCOMSOL) run on the license server. When a user starts 
COMSOL on a client computer, communication is established through the network 
from the client to the license server and the lmgrd daemon. The lmgrd daemon in turn 
makes a request to the daemon (LMCOMSOL) to release a license. The vendor daemon 
releases licenses according to the information contained in license.dat. The utility 
programs are used for license-server management. For more information on FlexNet 
management, see Chapter 7 in the FlexNet Licensing End Users Guide, available as a 
part of the FlexNet documentation and from the COMSOL Help Desk.

I N S T A L L I N G  T H E  L I C E N S E  M A N A G E R  F I L E S  

To install COMSOL on the same host as the license manager, first complete a 
COMSOL installation—this automatically installs the license manager files along with 
COMSOL (see Installing COMSOL). When finished, skip the remainder of this 
section and continue at Starting the License Manager.

If you want to install only the COMSOL license manager files, follow these 
instructions:

1 Insert the COMSOL 4.3 DVD into the DVD drive.

You should install the license manager only on the host(s) listed in 
license.dat.

Important
L I C E N S E  M A N A G E R  I N S T A L L A T I O N  |  109



110 |  C H A P T E
2 Follow the instructions starting with Installing COMSOL 4.3 until the Features 
screen is reached.

3 In the list of products to install, select only the License Manager check box.

4 Continue from the Features screen in the installation instructions to complete the 
license manager file installation.

Automated License Manager Installation
Alternatively, install the license manager using an automated installation process with 
minimal user interaction. See Automated Installation. Set licmanager = 1 in the 
answer file to install the license manager.

S T A R T I N G  T H E  L I C E N S E  M A N A G E R

Either start the license manager manually or let it run automatically at startup.

Starting the License Manager Manually
To start the license manager manually:

1 Launch the Terminal application.

2 Change directory to the license/maci32 directory 

cd /Applications/COMSOL43/license/maci32

3 Then enter

./lmgrd -c ../license.dat -l /var/tmp/comsol43.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol43.log.

Starting the License Manager Automatically at Startup
A folder COMSOL_Lmgr located in the folder COMSOL43/license/maci32 holds a script 
that can automatically start the license manager when you start the computer.By 
installing and configuring this folder, the license manager does not need to be started 
manually.

1 Go to the top level /Library folder on your startup disk.

2 In the Library folder, create a folder StartupItems if it does not already exist.

3 Move or copy the folder COMSOL_Lmgr to the StartupItems folder.

4 Open the file COMSOL_Lmgr in a text editor, for example, TextEdit.

5 Edit the line
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FP=<COMSOLPATH>

by replacing <COMSOLPATH> with the path to the COMSOL folder. If COMSOL is 
installed in the Applications folder this path is

FP=/Applications/COMSOL43

6 Edit the line 

USERNAME=<username>

by replacing <username> with your username.

Restart the computer to test the license manager installation. During startup a message 
Starting COMSOL License Manager should appear.

S T A R T I N G  C O M S O L

After the installation is complete and the license manager daemons are running on the 
license server(s) you can start using COMSOL.

Changing the License 

When a license file is changed, the license manager must be restarted; otherwise, it will 
continue to use the old license file still in memory.

R E S T A R T I N G  T H E  L I C E N S E  M A N A G E R

To restart the license manager:

1 Launch the Terminal application.

To run the COMSOL_Lmgr file it must have the correct file permission that 
include executable permission for the root user. To make sure that it has 
the correct permission, enter the following commands:

sudo chown root:wheel /Library/StartupItems/COMSOL_Lmgr/
COMSOL_Lmgr
sudo chmod 0755 /Library/StartupItems/COMSOL_Lmgr/
COMSOL_Lmgr

Note

If you have received a new license file—for example, when adding 
COMSOL products to an existing license—replace your current license 
file with the new one. Double-check the contents of this file to make sure 
it lists the products that your license includes.Note
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2 Change directory to the license/maci32 directory 

cd /Applications/COMSOL43/license/maci32

3 Enter the commands

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol43.log

Obtaining a Hostid

If COMSOL is already installed on your license server, you can determine the hostid 
by executing the lmhostid command

COMSOL43/license/$arch/lmhostid

where $arch is maci32 (32-bit Mac OS X) or maci64 (64-bit Mac OS X).

If COMSOL is not installed, a hostid must be obtained using the procedure in 
Obtaining the Hostid on Mac OS X. 

O B T A I N I N G  T H E  H O S T I D  O N  M A C  O S  X

1 Launch the application Network Utility found in the Applications/Utilities folder.

2 Click the Info tab to the left.

3 Select Network Interface (en0). This corresponds to your Ethernet card.

4 The hostid is the Hardware Address—as shown in the figure below, but with the 
colons (:) removed. If you plan to install on a Mac laptop with a wireless network 

All machine architectures use an Ethernet address (also called a MAC 
address) as the hostid. An Ethernet address has six bytes, each with two 
hexadecimal digits. Be sure to specify all twelve hex digits when using an 
Ethernet address as a hostid. For example, if the Ethernet address is 
8:0:20:0:5:ac specify 0800200005ac as the hostid.

Tip
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card, report the hardware address for both Network Interface (en0) and Network 

Interface (en1).
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T r oub l e s h oo t i n g  L i c e n s e  E r r o r s

This section summarizes the most common post-installation error messages generated 
by COMSOL, and it gives some advice how to troubleshoot them. Also check the 
COMSOL Support Knowledge Base at www.comsol.com/install for up-to-date 
information about installation and license issues.

TABLE 4-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, send the complete error message to 
support@comsol.com.

License error: -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

/var/tmp/comsol43.log

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

NOTE: The license manager creates the log file. If there is no log 
file, make sure to first start the license manager. Please refer to the 
section License Manager Installation for instructions how to 
install and start the COMSOL license manager. 

License error: -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com. The log file is usually placed here:

/var/tmp/comsol43.log
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License error: -15. 
Cannot connect 
to license server 
system.

The COMSOL license manager has not been installed or started 
yet. If the first line of your license.dat file looks like this:

   SERVER mylicserver 000123456789 1716

a license manager is required. Please refer to the section License 
Manager Installation for instructions how to install and start the 
COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if 
that helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client 
computer points to the correct license server hostname. First, find 
the license.dat file in the COMSOL application folder:

/Applications/COMSOL43/license/license.dat

Check that the first line has the correct license-server hostname. 
For example, if your license server hostname is mylicserver, the 
first row in the license.dat file should look like this:

   SERVER mylicserver 000123456789 1716

If the COMSOL client computer does not recognize 
mylicserver as a proper hostname, it might help to instead use 
the fully qualified domain name (mylicserver.mydomain.org) 
or the IP address. If neither of these work, there might be a 
problem with DNS or the HOSTS file on the client. Please ask 
your system administrator for advice on how to connect with 
TCP/IP to the license server.

Finally, the license manager might have encountered a problem 
during startup. Check the license manager log file for error 
messages. The log file is usually placed here:

/var/tmp/comsol43.log

NOTE: The log file is created by the license manager after it has 
been started.

Please send the log file to support@comsol.com if you want help 
in interpreting the information.

TABLE 4-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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License error: -39. 
User/host not on 
INCLUDE list for 
feature.

This error can only occur for the Named Single User License 
(NSL) license type. The error means that your username does not 
match the one listed in the license-manager options file, 
LMCOMSOL.opt. To get access to COMSOL, ask your license/
system administrator for help. When the username in the options 
file is changed, the license manager must be shut down and 
restarted to give the new user immediate access to COMSOL. 

License error: -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current 
local time and date. If the problem remains check that there are no 
files on your hard drive that are dated in the future.

License error: -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER hostname in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

The license.dat file is located in the COMSOL application 
folder:

/Applications/COMSOL43/license/license.dat

License error: -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages. The log file 
is usually placed here:

/var/tmp/comsol43.log

Note: The log file is created by the license manager after it has 
been started. 

Please send the log file to support@comsol.com if you want help 
in interpreting the information. 

TABLE 4-3:  GENERAL ERROR MESSAGES

ERROR MESSAGE EXPLANATION
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Runn i n g  COMSOL

In this section:

• The COMSOL Applications

• Running COMSOL from a Terminal Window

• Running a Classkit License

• Running COMSOL on Multicore and Multiprocessor Computers

• Running COMSOL in Batch Mode

The COMSOL Applications 

These applications provide different ways to run COMSOL:

• COMSOL Multiphysics—this is the primary application to run the software. It launches 
COMSOL Multiphysics as a standalone application.

• COMSOL Multiphysics (Classkit License)—this application launches COMSOL 
Multiphysics using a classkit license.

• COMSOL with MATLAB—use this application when you license the interface between 
COMSOL Multiphysics and MATLAB. 

The COMSOL applications do not work if moved outside the COMSOL 
folder. Create an alias if, for example, a desktop icon is required.

Caution

The COMSOL with MATLAB application requires that you use Apple’s 
X11 application together with MATLAB. The X-Windows application 
OroborOSX is not supported.

On Mac OS X 10.6 Snow Leopard you need to quit the Terminal 
application prior to run the COMSOL with MATLAB application.

Note

Note
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• COMSOL Multiphysics Server—this application launches the Terminal application and 
starts a COMSOL Multiphysics server in a terminal window.

Running COMSOL from a Terminal Window

COMSOL can also be launched from a terminal window using the shell script 
COMSOL43/bin/comsol.

To run the comsol command more easily, include the COMSOL43/bin directory in the 
path or make a symbolic link from /usr/bin/comsol to the comsol script. Those with 
administrator privileges can create a symbolic link with the command

sudo ln -s /Applications/COMSOL43/bin/comsol /usr/bin/comsol

(assuming COMSOL is installed in the Applications folder). This command asks for 
a password before creating the link. 

Running a Classkit License

To start COMSOL using a classkit license, start COMSOL using the -ckl option, for 
example

comsol -ckl

The comsol command must not be moved from the COMSOL43/bin 
folder. The COMSOL applications also use this script.

The COMSOL with MATLAB application requires that you use Apple’s X11 
application together with MATLAB. The X-Windows application 
OroborOSX is not supported.

Important

Note
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Running COMSOL on Multicore and Multiprocessor Computers

By default, a COMSOL process uses all cores and all processors on your computer 
using shared-memory parallelism. It uses the system environment variable 
NUMBER_OF_PROCESSORS  to determine the number of available cores and processors. 

Running COMSOL in Batch Mode

COMSOL batch jobs can be submitted from the COMSOL Desktop and the 
command line by right-clicking a Study node in the Model Builder and selecting Batch.

To override this behavior, see Shared-Memory Options.

Note

For command-line options, see COMSOL BATCH-specific arguments.
See Also
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Th e  COMSOL Command s

Use the COMSOL command to start COMSOL products with detailed start-up 
options.

The general syntax of the COMSOL command is

comsol [<target>] [<options>] [<target arguments>]

where square brackets indicate optional arguments. The comsol command can be 
combined with optional targets to achieve various results. The table below lists the 
command and targets.

The comsol command is located in the bin folder in the COMSOL installation 
directory.

I N I  F I L E S

There is a number of .ini files in the subdirectories maci32 and maci64 in the bin 
directory. It is sometimes recommended that you edit these files. For example, you can 
add options to any of the above commands by modifying the corresponding ini file. 
To change the option opt to value val, add the line

-Dopt=val

TABLE 4-4:  COMSOL COMMANDS TARGETS

COMMAND AND TARGET DESCRIPTION AVAILABILITY

comsol Run standalone 
COMSOL Multiphysics

comsol server Start COMSOL 
Multiphysics server

comsol client Run COMSOL 
Multiphysics client

comsol batch Run a COMSOL MPH 
file or class file

comsol compile Compile a Model Java file

comsol server matlab Start MATLAB and 
connect to a COMSOL 
server

Requires LiveLink for 
MATLAB license

comsol convertpre35a Convert 3.0–3.5 models
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to the file comsol.ini. Change the file comsolbatch.ini for comsol batch, and 
similarly for the other COMSOL targets.

O P T I O N S

You can enter various options after the COMSOL command and target. Table 4-5 lists 
the options (See [<options>] in the command syntax) available for all comsol 
commands. Always issue these options between the command and the target (if any).

TABLE 4-5:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE

-h Print general help

<target> -h Print target-specific help

-32 Run 32-bit COMSOL

-64 Run 64-bit COMSOL

-3drend ogl | sw 3D renderer: OpenGL 
or software rendering

-docroot <path> Specify custom path to 
the COMSOL 
documentation root 
directory.

See Documentation and 
Model Library Root 
Directories

-modelsroot <path> Specify custom path to 
the COMSOL Model 
Library root directory.

See Documentation and 
Model Library Root 
Directories

-np <no. of processors> Number of processors See Shared-Memory 
Options

-mpmode throughput | 
turnaround | owner

Multiprocessor mode See Shared-Memory 
Options

-blas {auto} | mkl | acml | 
path

BLAS library to use See BLAS Options

-blaspath <path> BLAS library path See BLAS Options

-ipv6 Activate IPv6 support

-prefsdir <path> Preference directory

-tmpdir <path> Temporary file directory

-version Print COMSOL version

-version <target> Print target version

-ckl Use classkit license
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For the -tmpdir option, COMSOL software uses the specified directory to store 
temporary files. The -prefsdir option specifies the directory where COMSOL 
should store the preference file.

Documentation and Model Library Root Directories
In a default COMSOL installation, the documentation files are located in the directory 
doc under the installation root directory. You can use the -docroot option if you want 
to move the documentation directory to a different location. Similarly, use the 
-modelsroot option if you want to move the Model Library root directory models 
from its default location under the COMSOL installation root. Relocating the 
documentation and Model Library root directories can be useful for administering 
Model Library Update; see Configuring Model Library Update.

Shared-Memory Options
Use the option -np to control the number of core and processors used. The default is 
to use all available cores and processors.

Depending on how loaded your machine is, you can control how COMSOL uses the 
available processors. The following options are available:

You may need to experiment to find the options that work best for your configuration.

-autosave <{on}|off> Control saving of 
recovery files

-recoverydir <path> Path to recovery 
directories

TABLE 4-6:  COMSOL MULTIPROCESSOR MODE OPTIONS

MPMODE OPTION DESCRIPTION

throughput Is expected to give the best performance when several different 
processes are running actively at the same time as COMSOL.

turnaround Typically provides the best performance when no other processes than 
COMSOL are active.

owner Provides the highest performance in most cases.

TABLE 4-5:  COMSOL OPTIONS (CURLY BRACKETS INDICATE DEFAULT VALUES)

COMSOL OPTION DESCRIPTION REFERENCE
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BLAS Options
BLAS is a set of functions for basic linear algebra operations. A large portion of the 
computational engine in COMSOL relies on BLAS. COMSOL provides the following 
BLAS-related options:

MKL is distributed along with COMSOL.

If you want to use a different BLAS library than the default, make sure that COMSOL 
can find the library. The simplest way for COMSOL to find a library is to put it in /
lib/ARCH where ARCH is the architecture (maci32 or maci64) or somewhere in the 
standard search path. You must also provide the path to any sublibraries needed by the 
library. You can also set the search path to point to the directory where the library is 
installed. To do so, use the environment variable DYLD_LIBRARY_PATH.

C O M S O L  C O M M A N D S

In additions to the options in Table 4-5, the standalone COMSOL command supports 
the following option.

C O M S O L  S E R V E R  C O M M A N D S

Use a COMSOL server command to start a COMSOL process ready to process 
computational requests. A COMSOL server listens for TCP/IP connections from 
COMSOL clients. A COMSOL Desktop can become a COMSOL client by 
connecting to a COMSOL server. The LiveLink interface for MATLAB also needs to 
connect to a COMSOL server.

The syntax for the COMSOL server command is

comsol [<options>] server [<target arguments>]

TABLE 4-7:  COMSOL BLAS OPTIONS

BLAS OPTION DESCRIPTION

auto Determine BLAS library automatically: MKL.

mkl Use the Intel MKL library.

path Use a BLAS library specified using the option -blaspath or the 
environment variable COMSOL_BLAS_PATH. The library must support 
the standard FORTRAN BLAS interface.

TABLE 4-8:  COMSOL COMMAND-LINE ARGUMENTS

COMSOL OPTIONS DESCRIPTION

-open <file> Open file
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The following target arguments are available for a COMSOL server command.

Accessing the COMSOL Server Computer
To access the computer running the COMSOL server simply log in on the server 
computer by using ssh or a similar command, then enter the comsol server 
command.

Login Information
When you start a COMSOL Multiphysics server for the first time, you are asked for a 
user name and password. Select a user name and a password, which COMSOL 
Multiphysics then uses in communications between the COMSOL Multiphysics client 
and the server. You must also specify a matching user name and password on the 
settings page in the Model Navigator, which opens when you start the COMSOL 
Multiphysics client. The software writes this login information in the file 
login.properties. The login information is located in Library/Preferences/
COMSOL/v43/login.properties in your home directory.

TABLE 4-9:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL SERVER OPTIONS DESCRIPTION

-user <user> Specify login name for a user

-port <port> Specify a TCP/IP port to listen for connect 
attempts.

-passwd reset|nostore Specify that you want to provide a new 
password.To avoid storing the new password on 
file use <nostore>

-login {info}|force|never Ask for login information. info means that only 
missing information is asked for.

-multi on|{off} Accept repeated client connections

-silent Do not listen to standard input
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Client/Server Security Issues
COMSOL Multiphysics can operate in a client/server mode where COMSOL 
Multiphysics runs as a separate client and a server. COMSOL Multiphysics uses a 
TCP/IP connection to send data between the server and the client.

Once you start a COMSOL Multiphysics server, a person with access to your login 
information could potentially connect to your COMSOL Multiphysics server. When a 
COMSOL Multiphysics client connects or disconnects from a remote computer, the 
COMSOL Multiphysics server displays a message. The connection from the client to 
the server is made with the TCP protocol.

The server and client are mutually authenticated using a challenge handshake 
authentication protocol, which means that login information cannot be easily obtained 
by someone eavesdropping on the network communication. The TCP connection 
between the client and the server is otherwise not encrypted. If you require encryption 
of the TCP connection, you can use third-party software based on protocols such as 
SSH or IPSEC.

C O M S O L  C L I E N T  C O M M A N D S

Use a COMSOL client command to start a COMSOL Desktop with a the Connect to 
Server dialog box open.

The syntax for the COMSOL client command is

comsol [<options>] client [<target arguments>]

The following target arguments are available for a COMSOL client command.

Always make sure that untrusted users cannot access the COMSOL login 
information. Protect the file Library/Preferences/COMSOL/v43/
login.properties. This is important when using COMSOL 
Multiphysics’ client/server feature. Alternatively, start the COMSOL 
server with the -passwd nostore option, and clear Remember Password 
when connecting to the server. This ensures that your login information 
is not stored on file.

Important

TABLE 4-10:  COMSOL TARGET COMMAND-LINE ARGUMENTS

COMSOL CLIENT OPTIONS DESCRIPTION

-port <port> Specify a TCP/IP port to connect to

-server <server name> Specify server to connect to

-open <file> Open file
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C O M S O L  B A T C H  C O M M A N D S

Use the COMSOL batch command to run COMSOL jobs without a GUI. You can 
run both Model MPH files and Model Java files with the COMSOL batch command. 
Model Java files need to be compiled before running.

The syntax for the COMSOL batch command is

comsol [<options>] batch [<target arguments>]

Its detailed target arguments are:

Example
To use the COMSOL Batch mode to solve a model, run the following command:

comsol batch -inputfile in.mph -outputfile out.mph -job b3 -pname v -plist 10

This command starts COMSOL Batch, solves the model in the Model MPH-file with 
the given file name using the active solver settings in the model, and stores the solution 
in the out.mph.

T H E  C O M S O L  C O M P I L E  C O M M A N D

The COMSOL compile command compiles a model Java file for use by the COMSOL 
batch command or for loading class files into the GUI. The syntax for the COMSOL 
compile command is

comsol [<options>] compile [<target arguments>] <file>.java

TABLE 4-11:  COMSOL BATCH-SPECIFIC ARGUMENTS

COMSOL BATCH OPTIONS DESCRIPTION

-inputfile <file name> Run a Model MPH-file or class file

-outputfile <file name> Save a Model MPH-file using the given file 
name. If output is not given, the input file 
will be overwritten with the output

-job <job tag> The batch job to run

-study <study tag> The study to compute

-pname <parameter name> Comma-separated list of parameter names

-plist <parameter value> Comma-separated list of parameter values

-batchlog <file name> File to store log in

-client Run as client

-host Connect to host

-port Connect to port

-nosave Do not save the resulting model
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The Java file is mandatory. The following optional target arguments are available‘

C O M S O L  M AT L A B  C O M M A N D

Use the COMSOL MATLAB command to access the COMSOL Java API through 
MATLAB. Type:

comsol server matlab [<options>]

which launches a COMSOL server in a console window, starts MATLAB, and 
connects MATLAB to the COMSOL server. 

The following options are available for the comsol server matlab command:

C O M S O L  C O N V E R T P R E 3 5 A  C O M M A N D

Use the comsol convertpre35a command to convert a directory with models made 
in COMSOL 3.0–3.5 to COMSOL 3.5a. To use the command, enter

comsol [<options>] <input directory> <output directory> [<logfile>]

where <input directory> is the input directory, <output directory> is the output 
directory, and [<logfile>] is an optional log file. If you do not provide the third 
argument, the log is printed on standard output.

TABLE 4-12:  COMSOL COMPILE OPTIONS

COMSOL COMPILE OPTIONS DESCRIPTION

-jdkroot <path> Path to the JDK root

-classpathadd <classpath> Additional classpath

-verbose Verbose output

TABLE 4-13:  COMSOL MATLAB OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-mlroot <path> MATLAB installation directory

-host <hostname> Connect to host

-port <hostname> Connect to port

-desktop Start with Desktop

-nodesktop Start without Desktop

-mlnosplash Start without MATLAB splash screen

TABLE 4-14:  COMSOL CONVERTPRE35A OPTIONS

COMSOL MATLAB OPTIONS DESCRIPTION

-c35aroot <path> Installation path of COMSOL 3.5a
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